Veritas™ Cluster Server Installation and Upgrade Guide


5.1 Service Pack 2
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

- A range of support options that give you the flexibility to select the right amount of service for any size organization
- Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
- Upgrade assurance that delivers software upgrades
- Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
- Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site at the following URL:

www.symantec.com/business/support/index.jsp

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

www.symantec.com/business/support/contact_techsupp_static.jsp

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

- Product release level
Hardware information
Available memory, disk space, and NIC information
Operating system
Version and patch level
Network topology
Router, gateway, and IP address information
Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:
www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:
www.symantec.com/business/support/
Customer Service is available to assist with non-technical questions, such as the following types of issues:
  - Questions regarding product licensing or serialization
  - Product registration updates, such as address or name changes
  - General product information (features, language availability, local dealers)
  - Latest information about product updates and upgrades
  - Information about upgrade assurance and support contracts
  - Information about the Symantec Buying Programs
  - Advice about Symantec's technical support options
  - Nontechnical presales questions
  - Issues that are related to CD-ROMs or manuals
Documentation

Your feedback on product documentation is important to us. Send suggestions for improvements and reports on errors or omissions. Include the title and document version (located on the second page), and chapter and section titles of the text on which you are reporting. Send feedback to:

doc_feedback@symantec.com

Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan customercare_apac@symantec.com
Europe, Middle-East, and Africa semea@symantec.com
North America and Latin America supportsolutions@symantec.com
# Contents

## Technical Support

| Technical Support | 4 |

## Chapter 1 Pre-installation and planning

<table>
<thead>
<tr>
<th>Installation requirements</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisites</td>
<td>9</td>
</tr>
<tr>
<td>Hardware requirements</td>
<td>10</td>
</tr>
<tr>
<td>Network requirements</td>
<td>10</td>
</tr>
<tr>
<td>Supported operating systems and application versions</td>
<td>12</td>
</tr>
<tr>
<td>Licensing</td>
<td>21</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Installation planning</th>
<th>22</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Symantec Product Authentication Service</td>
<td>23</td>
</tr>
<tr>
<td>About notification</td>
<td>23</td>
</tr>
<tr>
<td>About global clusters</td>
<td>24</td>
</tr>
<tr>
<td>Best practices</td>
<td>24</td>
</tr>
<tr>
<td>Recovery tools</td>
<td>25</td>
</tr>
</tbody>
</table>

## Chapter 2 Installing and Configuring Veritas Cluster Server

<table>
<thead>
<tr>
<th>About installing VCS</th>
<th>27</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing VCS using the product installer</td>
<td>27</td>
</tr>
<tr>
<td>Before installing VCS</td>
<td>28</td>
</tr>
<tr>
<td>Installing VCS</td>
<td>28</td>
</tr>
<tr>
<td>After installing VCS</td>
<td>31</td>
</tr>
<tr>
<td>Installing VCS using the command line</td>
<td>31</td>
</tr>
<tr>
<td>Repairing the installation</td>
<td>35</td>
</tr>
<tr>
<td>About reinstalling VCS</td>
<td>36</td>
</tr>
<tr>
<td>Adding or removing features</td>
<td>37</td>
</tr>
<tr>
<td>About configuring VCS cluster</td>
<td>38</td>
</tr>
</tbody>
</table>

## Chapter 3 Uninstalling Veritas Cluster Server

<table>
<thead>
<tr>
<th>Uninstalling using the product installer</th>
<th>39</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uninstalling from the command line</td>
<td>41</td>
</tr>
<tr>
<td>Uninstall command examples</td>
<td>43</td>
</tr>
</tbody>
</table>
Chapter 4  Upgrading Veritas Cluster Server ......................... 45
Upgrading the VCS cluster to VCS 5.1 SP2 ................................. 45
  Before you upgrade the cluster ........................................ 45
  Upgrading the cluster .................................................. 48
  After you upgrade the cluster to 5.1 SP2 ............................ 54
Upgrading an Exchange server cluster ................................. 56
  Upgrade scenarios ...................................................... 56
Upgrading a SQL server cluster .............................................. 57
  Upgrade scenarios ...................................................... 58
  Upgrading from Microsoft SQL Server 2000 to SQL Server
  2005 ..................................................................... 58
  Upgrading from Microsoft SQL Server 2000 or 2005 to SQL Server
  2008 or SQL Server 2008 R2 ........................................ 60
  Upgrading from Microsoft SQL Server 2008 or SQL Server 2008
  SP1 to SQL Server 2008 R2 ........................................ 64
Upgrading an Oracle cluster .................................................. 70
  Upgrade scenarios ...................................................... 70
  Upgrading Oracle in a VCS cluster .................................. 70
Upgrading the Microsoft service packs .................................. 76
  Upgrading to Microsoft Exchange 2003 SP2 in a VCS
  environment ............................................................. 77
  Upgrading to Microsoft Exchange Server 2007 SP3 in a VCS
  environment ............................................................. 78
  Upgrading from Microsoft Exchange 2010 to Exchange 2010 SP1
  in a VCS environment ................................................. 81
  Upgrading Microsoft SQL 2000 to SP4 in a VCS
  environment ............................................................. 81
  Upgrading Microsoft SQL 2005 to SP1 in a VCS
  environment ............................................................. 83
  Upgrading Microsoft SQL 2005 to 2005 SP2 or later in a VCS
  environment ............................................................. 85
  Upgrading Microsoft SQL 2008 or 2008 R2 with the latest service
  packs in a VCS environment ......................................... 89

Appendix A  Services and ports used by VCS .......................... 93
  About VCS services and ports .................................. 93

Index .............................................................................. 95
Pre-installation and planning

This chapter includes the following topics:

- Installation requirements
- Installation planning
- Best practices
- Recovery tools

Installation requirements

Veritas Cluster Server is supported on Windows-certified network servers containing one or more processors. Veritas Cluster Server supports clusters of up to 32 nodes.

The following sections provides details on the other installation requirements.

Prerequisites

Perform the following tasks before an installation:

- Review the release notes for your products
- Exit all running applications
- Ensure that you are a domain user having administrative privileges to the cluster nodes.
- Review the product installation requirements.
Hardware requirements

To determine the approved hardware refer to, the Hardware Compatibility List on the Symantec Support Web site.

http://www.symantec.com/docs/TECH138719

Table 1-1 provides the details on some of basic hardware requirements.

<table>
<thead>
<tr>
<th>Table 1-1</th>
<th>Hardware requirements</th>
</tr>
</thead>
</table>
| **Memory**                 | ■ Minimum required: 1GB  
  ■ Recommended: 2GB         |
| **Disk space**             | ■ 1 GB                |
| **System processor**       | ■ Minimum required: 300 MHz Pentium II  
  ■ Recommended: 550 MHz Pentium III or higher |
| **Display resolution**     | ■ Recommended: 1024 x 768 pixels or higher |

VCS Cluster Manager (Java Console) requires an 8-bit (256 color) display and a graphics card able to render 2D images.

**System requirements**

■ Shared disks to support applications that migrate between nodes in the cluster. Campus clusters require more than one array for mirroring. Disaster recovery configurations require one array for each site.

■ SCSI or Fibre Channel Host Bus Adapters (HBAs), or iSCSI Initiator supported NICs to access shared storage.

■ Two NICs: one shared public and private, and one exclusively for the private network; Symantec recommends three NICs: one public and two for the VCS private network.

Network requirements

Ensure that you have performed the following tasks and kept the required network information handy, before you install Veritas Cluster Server.

■ Verify that the systems on which you install the software are part of a Windows Active Directory domain.

■ Ensure that the static IP addresses are available for the following purposes:
  ■ One IP address per site for each virtual server.
  ■ One IP address for each physical node in the cluster
  ■ One IP address per cluster when configuring Notification. The same IP address can be used for other options, such as GCO.
- Configure name resolution for each node.
- Verify that the DNS Services are available. AD-integrated DNS or BIND 8.2 or higher are supported. Make sure a reverse lookup zone exists in the DNS. Refer to the application documentation for instructions on creating a reverse lookup zone.
- DNS scavenging affects virtual servers configured in VCS, because the Lanman agent uses Dynamic DNS (DDNS) to map virtual names with IP addresses. If you use scavenging, then you must set the DNSRefreshInterval attribute for the Lanman agent. This will enable the Lanman agent to refresh the resource records on the DNS servers. Refer to the Lanman agent description in the *Veritas Cluster Server Bundled Agents Reference Guide* for more information.
- Make sure that the NetApp filers and the systems on which you plan to install VCS reside in the same domain.
- Make sure that the NetApp filers are reachable; ensure that you can ping the filers using the DNS name.
- If you plan to set up a disaster recovery configuration, make sure that:
  - The volumes at both sites are of the same size.
  - The NetApp filers can replicate in both directions.
- If you plan to use Fibre Channel (FC) for connecting the LUNs, type hba_info on the command prompt, and verify that the FC initiators are displayed. If FC initiators are not displayed, install the mini port driver provided by your vendor and run the command again to verify that the FC initiators are displayed.
- Ensure that the LUNs are mounted. In case of Multi Pathing I/O (MPIO), ensure that the LUNs are mounted using the required initiators.

*Note:* MPIO support is available only with FC.

- Do not install VCS on servers that are assigned the role of a Domain Controller. Configuring a cluster on a domain controller is not supported.
- If the domain controller and the computer running the installation program are on different subnets, the installer may be unable to locate the computers selected for installation. In this situation, after the installation program displays an error message, type the host names and the IP addresses of the missing computers manually.
Supported operating systems and application versions

This section provides details on the supported application versions and the operating systems.

You must install the operating system in the same path on all systems. For example, if you install Windows 2003 on C:\WINDOWS of one node, installations on all other nodes must be on C:\WINDOWS. Make sure that the same drive letter is available on all nodes and that the system drive has adequate space for the installation.

Note: All VCS nodes must run the same Windows operating system and service pack level as well as the same VCS version and service pack level.

Supported operating systems

VCS supports the following Windows operating systems.

For the latest information on supported software, also see the Software Compatibility list at:

http://www.symantec.com/docs/TECH138722

Your server must run one of the following operating systems to install the VCS server components:

- Windows Server 2003 (32-bit): Web Edition: fully supports SFW and supports only file share for SFW HA (SP2 required for all editions)
- Windows Server 2003 for 64-bit Itanium (IA64): Enterprise Edition or Datacenter Edition (SP2 required for all editions)
- Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T): Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition (SP2 required for all editions)
- Windows Server 2003 x64 R2 Editions (for AMD64 or Intel EM64T): Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2 Edition (SP2 required for all editions)

- Windows Server 2008 for IA Systems (IA64) (SP1 or SP2)


- Windows Server 2008 R2 for IA Systems (IA64)

Your system must run one of the following operating systems to install VCS or VCS client software:

- Any one of the operating system versions, editions, and architectures that the Server Components are supported on.
- Windows 7
- Windows XP x86, x64 (including SP3)

**Microsoft Exchange servers and their operating systems**

Table 1-2 lists the supported Microsoft Exchange servers and the corresponding operating systems

<table>
<thead>
<tr>
<th>Microsoft Exchange servers</th>
<th>Operating systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2008 R2 on Standard x64 Edition, Enterprise x64 Edition</td>
<td></td>
</tr>
<tr>
<td>Microsoft Exchange servers</td>
<td>Operating systems</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
■ Windows Server 2008 x64 Editions (for AMD64 or Intel EM64T): Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition  
■ Windows Server 2008 R2 without Hyper-V on Standard, Enterprise, Datacenter Editions  
■ Windows Server 2008 R2 for IA Systems - IA64  
■ Windows Server 2008 x64 R2 Web Edition |

**Microsoft SQL servers and their operating systems**

*Table 1-3* lists the supported Microsoft SQL servers and the corresponding operating systems.
## Microsoft SQL Servers and operating systems

<table>
<thead>
<tr>
<th>Microsoft SQL Servers</th>
<th>Operating systems</th>
</tr>
</thead>
</table>
Windows Server 2003 x64 R2 Editions: Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2 Edition (SP1 required for all editions, SP2 supported) |
Windows Server 2003 Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition (SP2 supported for all editions)  
Windows Server 2003 x64 R2 Editions: Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2 Edition (SP2 supported for all editions) |
Table 1-3  Microsoft SQL Servers and operating systems (continued)

<table>
<thead>
<tr>
<th>Microsoft SQL Servers</th>
<th>Operating systems</th>
</tr>
</thead>
</table>
- Windows Server 2008 x64 R2 without Hyper-V on Standard, Enterprise, Datacenter Editions  
- Windows Server 2008 R2 for IA Systems - IA64  
- Windows Server 2008 x64 R2 Web Edition |
| Microsoft SQL Server 2005, (64-bit) Standard Edition or Enterprise Edition (SP1, SP2 and SP3 for all editions) | - Windows Server 2003 for Itanium-based systems: Enterprise Edition or Datacenter Edition (SP1 required for all editions, SP2 supported)  
- Windows Server 2003 Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition (SP2 supported for all editions)  
- Windows Server 2003 x64 R2 Editions: Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2 Edition (SP2 supported for all editions)  
- Windows Server 2008 for 64-bit Itanium (IA64)  
- Windows Server 2008 x64 Editions (for AMD64 or Intel EM64T): Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition  
- Windows Server 2008 x64 R2 without Hyper-V on Standard, Enterprise, Datacenter Editions  
- Windows Server 2008 R2 for IA Systems - IA64  
- Windows Server 2008 x64 R2 Web Edition |
**Table 1-3**  Microsoft SQL Servers and operating systems *(continued)*

<table>
<thead>
<tr>
<th>Microsoft SQL Servers</th>
<th>Operating systems</th>
</tr>
</thead>
</table>
■ Windows Server 2003 for Itanium-based Systems Enterprise Edition or Datacenter Edition (SP2 required for both)  
■ Windows Server 2003 Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition (SP2 required)  
■ Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T): Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2 Edition (SP2 required)  
■ Windows Server 2008 x64 R2 without Hyper-V on Standard, Enterprise, Datacenter Editions  
■ Windows Server 2008 R2 for IA Systems - IA64  
■ Windows Server 2008 x64 R2 Web Edition |
Table 1-3  Microsoft SQL Servers and operating systems (continued)

<table>
<thead>
<tr>
<th>Microsoft SQL Servers</th>
<th>Operating systems</th>
</tr>
</thead>
</table>
■ Windows Server 2003 Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition (SP2 required)  
■ Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T): Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2 Edition (SP2 required)  
■ Windows Server 2008 x64 R2 without Hyper-V on Standard, Enterprise, Datacenter Editions  
■ Windows Server 2008 R2 for IA Systems - IA64  
■ Windows Server 2008 x64 R2 Web Edition |
■ Windows Server 2003 Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition (SP2 required)  
■ Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T): Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2 Edition (SP2 required)  
■ Windows Server 2008 x64 R2 without Hyper-V on Standard, Enterprise, Datacenter Editions  
■ Windows Server 2008 R2 for IA Systems - IA64  
■ Windows Server 2008 x64 R2 Web Edition |
Note: Microsoft SQL Server 2000 and Microsoft SQL Server 2005 can exist in the same cluster and operate on or fail over to the same systems. However, only one default instance can exist on a system at one time. Additional instances that operate on or fail over to that system must be named instances. The number of named instances is limited only by the normal limit of instances for that version of SQL Server.

Note: Similarly, Microsoft SQL Server 2005 and Microsoft SQL Server 2008 can exist in the same cluster and operate on or fail over to the same systems. However, only one default instance can exist on a system at one time. Additional instances that operate on or fail over to that system must be named instances. The number of named instances is limited only by the normal limit of instances for that version of SQL Server.

## Oracle versions and their operating systems

Table 1-4 lists the supported Oracle versions and the corresponding operating systems

<table>
<thead>
<tr>
<th>Oracle versions</th>
<th>Operating systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Windows Server 2003 for Itanium-based Systems Enterprise Edition or Datacenter Edition (SP2 required for both)</td>
<td></td>
</tr>
<tr>
<td>Oracle versions</td>
<td>Operating systems</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
- Windows Server 2003 for Itanium-based Systems Enterprise Edition or Datacenter Edition (SP2 required for both)  

Table 1-4: Oracle versions and operating systems (continued)
Supported applications

The supported versions of Network Appliance applications and other other applications are as follows:

- Network Appliance SnapManager for Exchange 3.2 with Exchange Server 2003
- Network Appliance SnapManager for Exchange 4.0, 5.0, 6.0 with Exchange Server 2007
- Network Appliance SnapManager for SQL 2.0, 2.1, and 5.0
- Network Appliance Data ONTAP 7.3, 7.3.3
- Network Appliance SnapDrive 4.1, 4.2.1, 5.0, 6.0, 6.1, and 6.2
  When installing SnapDrive, you must specify a user account in the SnapDrive Service Credentials dialog box. The user account must be a domain user and part of the Administrators group of the local system and the filer.
- Data ONTAP DSM for Windows MPIO 3.1, 3.2, 3.3, 3.3.1
- Microsoft iSCSI software initiator version 2.03 or later versions

Licensing

Each copy of Veritas Cluster Server including all options and agents, whether used on a physical server or within a virtual machine, must be licensed according to the conditions set forth in the sections below. Each Licensed Software license specifies the number of instances of the licensed software you may run on a particular server at one time.

*Table 1-5* lists Veritas Cluster Server editions and the additional licensing terms that apply.

<table>
<thead>
<tr>
<th><em>Microsoft Operating System Edition</em></th>
<th><em>Veritas Cluster Server licensing terms</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Server Edition</td>
<td>A separate license for the licensed software is required for each virtual or physical server, where the software is installed.</td>
</tr>
<tr>
<td>■ Standard Edition</td>
<td></td>
</tr>
<tr>
<td>■ Web Edition</td>
<td></td>
</tr>
<tr>
<td>■ Advanced Edition</td>
<td>For each license, you may run one instance of the licensed software on one physical server and up to four simultaneous instances of the licensed software on virtual servers located on the physical server.</td>
</tr>
<tr>
<td>■ Enterprise Edition</td>
<td></td>
</tr>
</tbody>
</table>
Table 1-5  Veritas Cluster Server licensing terms (continued)

<table>
<thead>
<tr>
<th>Microsoft Operating System Edition</th>
<th>Veritas Cluster Server licensing terms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datacenter Edition</td>
<td>For each license, you may run one instance of the licensed software on one physical server and an unlimited number of virtual servers located on the physical server.</td>
</tr>
</tbody>
</table>

Evaluation license key

An evaluation license key is embedded in the product. To use this key, click Next at the license key entry screen of the product installer. This license key is valid for a period of two months only.

Virtual Server license policy

Each copy of the Veritas Cluster Server including all options and agents, whether used on a physical server or within a virtual machine must be separately licensed. Each Licensed Software license specifies the number of instances of the Licensed Software you may run on a particular server at one time.

License management

The product installer lets you add and remove specific licenses. Adding a license for an option does not install the option. Use the Add/Remove function to install an option. License keys support installation on multiple systems.

Note: License keys for releases 4.x of VCS are not supported. A default evaluation license key is supplied for your use. This license key is valid for a period of two months only. You must purchase the product to obtain a permanent license key.

Installation planning

You can install VCS and the other applicable options using the product installer and the CLI. During the installation you can choose to simultaneously install the product on more than one system.

After the installation is complete, run the Veritas Cluster Server Configuration Wizard to complete the VCS cluster configuration. The Veritas Cluster Server Configuration Wizard presents the opportunity to configure optional VCS features including security options, notification, and the global cluster wide-area connection resource.
Depending on your environment you may choose to configure the Symantec Product Authentication Service on systems outside the cluster.

Review the following sections and decide how you want to configure your environment:

- About Symantec Product Authentication Service
- About upgrading VCS while in co-existence with Veritas NetBackup
- About notification
- About global clusters

### About Symantec Product Authentication Service

Symantec Product Authentication Service allows the security administrator to configure authentication for domain and local users to work with VCS such that these users can logon to the java console without providing a password.

The Authentication Service provides the ability to configure a cluster in a secure mode. It also secures communication between cluster nodes and clients, including the Java console, by using digital certificates for authentication and SSL to encrypt communication over the public network.

To configure the cluster in secure mode, VCS requires you to specify and configure a system in your environment as a root broker and all nodes in the cluster as authentication brokers.

Table 1-6 defines the root broker and authentication broker.

<table>
<thead>
<tr>
<th>Broker type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root broker</td>
<td>A root broker serves as the main registration and certification authority. It is the single authority which validates requests from authentication brokers that are installed on the (cluster) systems.</td>
</tr>
<tr>
<td>Authentication broker</td>
<td>Authentication brokers serve as intermediate registration and certification authorities. Authentication brokers have certificates that are signed by the root. Each node in the cluster serves as an authentication broker.</td>
</tr>
</tbody>
</table>

### About notification

You can configure VCS to send event notification either through SMTP email notification or SNMP traps.
Configuring the notifier process may be done during initial cluster configuration or at a later time using the VCS Configuration Wizard.

For additional information, refer to the Veritas Cluster Server Administrator’s Guide.

About global clusters

A global cluster consists of two or more clusters linked together. Global clusters provide the ability to fail over applications between geographically distributed clusters when disaster occurs.

Global clusters may be configured using the Global Group Configuration Wizard (that can be accessed through VCS Cluster Manager-Java Console). This requires a wide-area connector (WAC) resource for inter-cluster communication. This resource can be optionally configured using the VCS Configuration Wizard.

For information about the Global Group Configuration Wizard and Veritas Cluster Server Configuration Wizard, refer to Veritas Cluster Server Administrator’s Guide.

Best practices

Symantec recommends that you perform the following tasks before you begin to install VCS:

- Verify that you have at least three network adapters (with at least two NICs exclusively for the private network and one for the public network). When using only two NICs, lower the priority of one NIC and use the low-priority NIC for public and private communication.

- Route each private NIC through a separate hub or switch to avoid single points of failure.

- NIC teaming is not supported for the private network.

- Verify that you have set the Dynamic Update option for the DNS server to Secure Only.

- Configure Microsoft Exchange Server and Microsoft SQL Server on separate failover nodes within a cluster.

- In case of Windows Server 2008, if User Access Control is enabled ensure that you perform the steps mentioned in the following Microsoft KB, before you begin to install VCS.

  http://support.microsoft.com/kb/957307
Recovery tools

Symantec provides a cleanup script and 'vxexplorer' recovery tool for the failed VCS 5.1 SP2 installs, uninstalls, or upgrades. This script and recovery tool can be downloaded from the following Symantec link:

http://www.symantec.com/docs/TECH76129
Installing and Configuring Veritas Cluster Server

This chapter includes the following topics:

- About installing VCS
- Installing VCS using the product installer
- Installing VCS using the command line
- Repairing the installation
- About reinstalling VCS
- Adding or removing features
- About configuring VCS cluster

About installing VCS

This chapter describes the process for installing Veritas Cluster Server 5.1 SP2. You can install VCS using either the product installer or the command line interface (CLI).

Installing VCS using the product installer

This section outlines the tasks for installing VCS, using the product installer.
Before installing VCS

Before installing the software on remote systems running Windows 2003, you must modify the driver signing options to ignore warning messages about software authentication.

**To modify the driver signing options**

1. Open the Driver Signing Options dialog box by using either of the following methods:
   - From Windows Explorer, right-click **My Computer**, and click **Properties**. On the Hardware tab, click **Driver Signing**.
   - Open the Control Panel and double-click **System**. On the Hardware tab, click **Driver Signing**.

2. In the Driver Signing Options dialog box, select **Ignore**, and click **OK**.

**Installing VCS**

**To install the product using the installer**

1. Insert the product software disc into your disc drive and allow the autorun feature to start the installation or from the Windows Explorer, navigate to the root directory of the Veritas Cluster Server installation media and double-click **Setup.exe**.

2. Under Install Veritas Cluster Server, click **Complete/Custom**.

   The Complete/Custom installation installs server components and optional client components. Click **Administrative Console** if you wish to install only the client components. This will install the VCS Java Console.

3. Review the information on the Welcome panel and click **Next**.

4. On the License Agreement panel, review the License Agreement and select **I accept the terms of License Agreement**. Click **Next**.
5 On the License panel, select **Enter license key(s)**, type the license key, click **Add**, and then click **Next**. The License key details section displays more information about the selected key.

If you do not have a license key, select **Use embedded 2-month evaluation key** and click **Next**.

To delete a license key, select the key from the key list and click **Remove**.

6 On the Option Selection panel, select any of the following product options and click **Next**:

- Veritas Cluster Server 5.1 SP2 for Windows (Server Components)
- Global Clustering Option
  Select this option if you plan to configure a disaster recovery environment.
- High Availability Hardware Replication Agents
  - Veritas Cluster Server Hardware Replication Agent for NetApp
- High Availability Application Agents
  - Veritas Cluster Server Application Agent for Exchange 2003
    This option is available only on 32-bit machines.
  - Veritas Cluster Server Application Agent for Exchange 2007
    This option is available only on 64-bit machines.
  - Veritas Cluster Server Database Agent for Exchange 2010
    This option is available only on 64-bit machines.
- High Availability Database Agents
  - Veritas Cluster Server Database Agent for SQL
    This installs the VCS agent for both, SQL Server 2005 and SQL Server 2008
  - Veritas Cluster Server Database Agent for Oracle
- Enterprise Vault (EV) Cluster Setup Wizard
- Product Documentation
- Veritas Cluster Server 5.1 SP2 for Windows (Client Components)
  This installs the VCS Java Console on the same nodes where the server components are installed.

7 On the System Selection panel, add the systems on which you want to install the product.
**Note:** Ensure that all the nodes have the same platform type (x86 or x64). The Windows operating systems can be different though.

You can select the systems in one of the following ways:

- In the System Name text box, manually type the system name and click **Add**.

- Alternatively, browse to select the systems.

  On the Select Systems panel, the systems that belong to the domain in which you have logged in are listed in the Available Systems list. Select one or more systems and click the right arrow to move them to the Selected Systems list. Click **OK**.

  Once you add or select a system, the wizard performs the verification checks and notes the verification details. To review the details, click the corresponding information icon.

  By default the wizard uses `%ProgramFiles%\Veritas` as the installation directory. However, you can customize your installation directory. To customize the installation directory, click the adjacent browse icon and select the desired location. Click **OK**.

8. After the installer validates the systems for the installation, click **Next**.

   Note that the installer fails to proceed with the installation, unless all the selected systems have passed the verification checks and are ready for installation. In case the verification checks have failed on any of the system, review the details and rectify the issue. Before you choose to proceed with the installation click **Re-verify** to re-initiate the verification checks for this system.

9. On the Pre-install Summary panel, review the summary and click **Next**.

   Note that the **Automatically reboot systems after installer completes operation** check box is selected by default. This will reboot all the selected remote systems immediately after the installation is complete on the respective system. If you do not want the wizard to initiate this auto reboot, clear the selection of **Automatically reboot systems after installer completes operation** check box.

10. On the Installation panel, review the progress of installation and click **Next** after the installation is complete.

    If an installation is not successful on any of the systems, the status screen shows a failed installation. If a security alert asks you to accept the Veritas driver software, click **Yes**.
11 On the Post-install Summary panel, review the installation result and click Next. If the installation has failed on any of the system, refer to the log file for details.

12 On the Finish panel, click Finish. If you had chose to initiate the auto reboot, a confirmation message to reboot the local system appears. Click Yes to reboot immediately or No to reboot later.

In case you had not selected to initiate the auto reboot, ensure that you manually reboot these systems.

After installing VCS

To ensure a secure system environment, after completing the installation sequence, reset the driver signing options on each computer to the original state of Warn or Block.

To reset the driver signing options

1 Open the Control Panel and click System.
2 Select the Hardware tab and click Driver Signing.
3 In the Driver Signing Options dialog box, reset the option to Warn or Block.
4 Click OK to close the Driver Signing Options dialog box, and then click OK again to close the System window.
5 Repeat for each computer.

Installing VCS using the command line

You can perform a silent installation from the command prompt using the Setup.exe command. A silent installation can be performed only on one node at a time. See the examples at the end of this section for reference.

To start the installation from the command window

1 Insert the product software disc into a drive connected to the system.
2 Click Start > Run.
3 Enter cmd in the Open field and click OK.
4  From the command window, navigate to the root directory of the product software disc.

5  Use the following command to install the software:

```
Setup.exe /s Solutions="SolutionID,[SolutionID]"
Install_mode=<InstallMode>
Installdir=<"InstallDirPath">  Reboot=<RebootMode>
target=<"machine name">  Licensekey="LicenseKey"
options="a,b,c,..."
```

where the maximum length of the argument string is 512 characters.

Parameters for setup.exe

Table 2-1 lists the information about the possible parameter values for the setup.exe.

**Table 2-1**  Possible parameter values

<table>
<thead>
<tr>
<th>/s</th>
<th>Set for silent mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install_mode</td>
<td>Set to indicate an install or uninstall.</td>
</tr>
<tr>
<td></td>
<td>1 = To install</td>
</tr>
<tr>
<td></td>
<td>4 = To repair</td>
</tr>
<tr>
<td></td>
<td>5 = To uninstall</td>
</tr>
<tr>
<td></td>
<td>The default setting is 1.</td>
</tr>
<tr>
<td></td>
<td>Example: Install_mode=1</td>
</tr>
<tr>
<td>Solutions</td>
<td>Set to the type of installation.</td>
</tr>
<tr>
<td></td>
<td>6 = VCS Server Components</td>
</tr>
<tr>
<td></td>
<td>7 = VCS Client Components</td>
</tr>
<tr>
<td></td>
<td>Example: Solutions=&quot;6,7&quot;</td>
</tr>
<tr>
<td>Parameter</td>
<td>Setting</td>
</tr>
<tr>
<td>-------------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| **Install_dir** | Set the installation directory path. The path must start and end with a quotation mark. **Note:** If you are upgrading to VCS 5.1SP2, the installation directory path used during existing VCS installation is used by default. New path provided, if any, is not considered. The default setting is **SystemDrive:** \\Program files\\Veritas.
Example: `INSTALLDIR="C:\InstallationDirectory"`
**Note:** This is an optional parameter.
| **Reboot** | Set for the automatic reboot of the system at the completion of the installation. 0 = No reboot 1 = Reboot The default setting is 0 for no system reboot.
Example: `Reboot=1` **Note:** This is an optional parameter.
| **Node** | Set the node name. Specify only one node at a time.
The local node is the default setting when the node is unspecified.
Example: `Node="PC177VM-3"`
| **Target** | Specify the machine name for the system where you want to install the software. Make sure you place the machine name between quotes.
Local node is the default setting.
Example: “PC177VM-3” This is an optional parameter.
Table 2-1 Possible parameter values (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| LicenseKey | Set the license key for the installation. Enter multiple keys by separating them with a comma (e.g. 123-345-567-789-123, 321-543-765-789-321, etc.) The license key must start and end with a quotation mark ("). LicenseKey has no default setting.
Example: LICENSEKEY="123-234-123-234-345"
**Note:** If the license key is not specified, an embedded 60 days demo license key is set by default. |
| Options    | Set the desired options, if any. The option must start and end with a quotation mark ("). Multiple options can be entered, use a comma as a separator.
There are no default settings.
The options for VCS are:
- ntap
- GCO
- exchange
- sql
- oracle
- ev
Example: OPTIONS="GCO" |

Setup.exe example: Client installation

This sample command installs the client components at the specified installation path and tells the system not to reboot at the end of the installation.

```
Setup.exe /s Solutions=7 Install_mode=1
Installdir="C:\InstallationDirectory"
```

Setup.exe example: Server installation

This sample command installs the server components in the directory `C:\InstallationDirectory` and tells the system to reboot at the end of the installation. It also installs with a license key of 123-234-123-234-345, and with the GCO option.
Repairing the installation

The product installer can repair an existing installation of the VCS client and server components.

The **Repair** option restores the installation to its original state. This option fixes missing or corrupt files, shortcuts, and registry entries on the local computer.

---

**Note:** Before you proceed to repair the installation, you must save your configuration to another system and failover the service groups for your applications to another node.

---

**Note:** You can repair the installation only on the local system. Also, you must repair the client and server components separately.

---

**To repair the installation**

1. Open the Windows Control Panel and click **Add or Remove Programs**.
   
   In case you are working on Windows Server 2008, go to **Programs and Features**. 
   
   
   (Start > Settings > Control Panel > Programs and Features)

2. Scroll to Veritas Cluster Server 5.1 SP2 for Windows and select it.
   
   For example, select Veritas Cluster Server 5.1 SP2 for Windows (Server Components) or Veritas Cluster Server 5.1 SP2 For Windows (Client Components).

3. Click **Change**.
   
   The Symantec Product Installer screen appears.

4. On the Mode Selection panel, select **Repair**. Click **Next**.
5 On the System Selection panel, installer performs the verification checks. Click Next once the status is “Ready for repair”.

**Note:** Wizard displays the verification check results only for one of the component, in case during the installation you have installed the server and client components on different drives but have now chose to repair both the components. Proceed with the steps to repair the installation of both the components.

In case the verification checks have failed on any of the system, review the details and rectify the issue. Before you choose to proceed with the installation, click Re-verify to re-initiate the verification checks for this system.

6 On the Pre-install Summary panel, review the information and click Next to begin the repair process.

Note that the **Automatically reboot systems after installer completes operation** check box is selected by default. This will reboot the node immediately after the repair operation is complete. If you do not want the wizard to initiate this auto reboot, clear the selection of **Automatically reboot systems after installer completes operation** check box.

7 On the Installation panel, review the installation progress and click Next after the installation is complete.

If the installation fails, click Next to review the report and address the reason for failure. You may have to uninstall and reinstall the software.

8 On the Post-install Summary panel, review the summary and click Next.

9 On the Finish panel, click Finish.

In case you had not selected to initiate the auto reboot, ensure that you manually reboot the node.

**About reinstalling VCS**

If your VCS installation has failed due to some reason, you can choose to reinstall it without uninstalling the components that were installed during the failed attempt.

**Note:** You must reboot your system before you begin to reinstall VCS.

To reinstall VCS launch the product installer, possibly after you have rectified the cause of failure and follow the wizard steps for installation.
See “Installing VCS using the product installer” on page 27.

During installation, wizard displays a confirmation message on the System Selection panel. Click Yes to proceed with the installation.

Adding or removing features

After you have installed VCS, you may need to add or remove features to your application. The product installer lets you add or remove features.

**Note:** You can add or remove features on the local system only.

**To add or remove features**

1. Open the Windows Control Panel and click **Add or Remove Programs**. In case of a Windows Server 2008 node, go to **Programs and Features**.
2. Select **Veritas Cluster Server 5.1 SP2 for Windows (Server Components)** and click **Change**.
3. On the Product Installer’s **Mode Selection** panel, select **Add or Remove** and then click **Next**.
4. On the Option Selection panel, select or clear the option check boxes in the tree navigation structure to add or remove a component respectively.

   **Note** that only the options included in your product license, will be enabled for selection. To select any other option, you must first enter the required license details. For details, refer to,

   In case the verification checks have failed, review the details and rectify the issue. Before you choose to proceed with the installation click **Re-verify** to re-initiate the verification checks.

5. On the Pre-install Summary panel, review the summary and click **Next**.

   **Note** that the Automatically reboot systems after installer completes operation check box is selected by default. This will reboot all the selected remote systems immediately after the installation is complete on the respective system. If you do not want the wizard to initiate this auto reboot, clear the selection of Automatically reboot systems after installer completes operation check box.
6 On the Installation panel, review the progress of installation and click **Next** after the installation is complete.

   If an installation is not successful, the status screen shows a failed installation. Refer to the Post-install summary for more details. Rectify the issue and then proceed to re-install the component.

   If a security alert asks you to accept the Veritas driver software, click **Yes**.

7 On the Post-install Summary panel, review the installation result and click **Next**.

   If the installation has failed, refer to the log file for details.

8 On the Finish panel, click **Finish**.

   If you had chose to initiate the auto reboot, a confirmation message to reboot the local system appears. Click **Yes** to reboot immediately or **No** to reboot later.

   In case you had not selected to initiate the auto reboot, ensure that you manually reboot these systems.

### About configuring VCS cluster

After installing the software, set up the components required to run Veritas Cluster Server. The VCS Configuration Wizard sets up the cluster infrastructure, including LLT and GAB, and provides an option of configuring the Symantec Product Authentication Service in the cluster. The wizard also configures the ClusterService group, which contains resources for notification, and global clusters.

- If you plan to set up a disaster recovery environment, configure the widearea connector process for global clusters.

- When configuring a user account for the VCS Helper service, choose the administrative account set up on the filer

For instructions, see the chapter on Getting Started with VCS in the *Veritas Cluster Server Administrator’s Guide*. 
Uninstalling Veritas Cluster Server

This chapter includes the following topics:

- Uninstalling using the product installer
- Uninstalling from the command line

Uninstalling using the product installer

The Symantec Product Installer enables you to uninstall the product software. You can simultaneously uninstall the product from multiple remote nodes. To uninstall the product from remote nodes, ensure that the product is installed on the local node.

If you have installed both, the Server and the Client components, then you are presented with both the options in the Windows Add or Remove Programs to uninstall the software. Uninstallation of Server components is independent of the client uninstallation. You can however choose to uninstall the client while uninstalling the Server components.

Note: For uninstalling VCS, you must first unconfigure the cluster. Use the Veritas Cluster Wizard (VCW) to unconfigure the cluster. See the Veritas Cluster Server Administrator’s Guide for more information.

The following procedure describes the steps required to completely uninstall the product software (Server and Client components). If you want to uninstall any one of the other installed options, you must choose the Add or Remove feature. See “Adding or removing features” on page 37.
To uninstall using the product installer

1. In the Windows Control Panel, select **Add or Remove Programs**.
   In case you are working on Windows Server 2008, go to **Programs and Features**.

2. Click **Veritas Cluster Server 5.1 SP2 for Windows (Server Components)**.
   **Note:** If you select **Veritas Cluster Server 5.1 SP2 for Windows (Client Components)**, it will uninstall the client components only.

3. Click **Remove**.
   In case of Windows Server 2008, click **Uninstall**.

4. Review the information on the Welcome panel and then click **Next**.

5. On the Options Selection panel, select the options you want to uninstall.
   Click **Next**.

6. On the System Selection panel, add the nodes from which you want to uninstall the product software.
   **Note:** By default the local system is selected for un-installation. In case you are performing a remote un-installation and do not want to uninstall the software from the local system, click the corresponding **X** icon to remove the node from the list.

You can add the nodes this in one of the following ways:

- In the System Name text box, manually type the node name and click **Add**.
- Alternatively, browse to select the nodes.
  The nodes that belong to the domain in which you have logged in are listed in the Available Systems list. Select one or more nodes and click the right arrow to move them to the Selected Systems list. Click **OK**. Once you add or select a node, wizard performs the verification checks and notes the verification details. To review the details, click the corresponding information icon.
7  Click Next.

Note that the wizard fails to proceed with the un-installation, unless all the selected nodes have passed the verification checks and are ready for uninstallation. In case the verification checks have failed on any of the system, review the details and rectify the issue. Before you choose to proceed with the un-installation click Re-verify to re-initiate the verification checks for this node.

Note: Wizard displays the verification check results only for one of the component, in case during the installation you have installed the server and client components on different drives but have now chose to uninstall both the components. Proceed with the uninstallation to uninstall both the components.

8  On the Pre-install Summary panel, review the summary and click Next.

Note that the Automatically reboot systems after installer completes operation check box is selected by default. This will reboot the remote systems immediately after the installation is complete on the respective system. If you do not want the wizard to initiate this auto reboot, clear the selection of Automatically reboot systems after installer completes operation check box.

9  On the Installation panel, review the uninstallation progress and click Next when the uninstallation is complete.

10 On the Post-uninstall Summary panel, review the uninstallation results and click Next.

   If the un-installation has failed on any of the system, review its summary report and check the log file for details.

11 On the Finish panel, click Finish.

   In case you had not selected to initiate the auto reboot for the remote nodes, ensure that you manually reboot these nodes.

Uninstalling from the command line

You can silently uninstall the VCS software from the command prompt using the setup.exe command.

The setup.exe command syntax is as follows:
**Setup.exe** /s INSTALL_MODE=InstallMode
SOLUTIONS="1,2,3,..." [REBOOT=RebootMode] [NODE="SysA"]

Table 3-1 displays information about the possible parameter values for uninstalling the VCS software:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>/s</td>
<td>Set for silent mode.</td>
</tr>
<tr>
<td>INSTALL_MODE</td>
<td>Set to indicate an install or uninstall.</td>
</tr>
<tr>
<td></td>
<td>1 = To install</td>
</tr>
<tr>
<td></td>
<td>4 = To repair</td>
</tr>
<tr>
<td></td>
<td>5 = To uninstall</td>
</tr>
<tr>
<td></td>
<td>The default setting is 1 to install. Set this parameter to 5 for uninstall. Example: INSTALL_MODE=5</td>
</tr>
<tr>
<td>SOLUTIONS</td>
<td>Set to the type of uninstallation.</td>
</tr>
<tr>
<td></td>
<td>6 - VCS Server Components</td>
</tr>
<tr>
<td></td>
<td>7 - VCS Client Components</td>
</tr>
<tr>
<td></td>
<td>Example: Solutions=&quot;6,7&quot;</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To uninstall the server and matching client components, run two setup.exe /s commands, one with the Solution parameter set for the server component and the other set for the matching client component.</td>
</tr>
<tr>
<td>REBOOT</td>
<td>Set for the automatic reboot of the system at the completion of the installation.</td>
</tr>
<tr>
<td></td>
<td>0 = No reboot</td>
</tr>
<tr>
<td></td>
<td>1 = Reboot</td>
</tr>
<tr>
<td></td>
<td>The default setting is 0 for no system reboot.</td>
</tr>
<tr>
<td></td>
<td>Example: REBOOT=1</td>
</tr>
</tbody>
</table>
### Table 3-1 Parameters for uninstalling the software (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Use</th>
</tr>
</thead>
</table>
| NODE      | Set the node name.  
You can enter only one node at a time.  
The local node is the default setting when the node is unspecified.  
The machine name of the node must start and end with a quotation mark (").  
Example: Node="SysA" |

**Note:** Reboot the system at the end of uninstallation to ensure that the VCS drivers for the server component are installed correctly. You do not have to reboot after uninstalling the client.

The following procedure describes how to uninstall the software from the command prompt.

**To uninstall from the command prompt**

1. Open a command window by clicking **Start > Run**.
2. Enter `cmd` in the Open field and click **OK**.
3. In the command window, navigate to the root directory of the product DVD.
4. Use the following command syntax to silently uninstall VCS:
   ```
   Setup.exe /s INSTALL_MODE=InstallMode 
   SOLUTIONS="1,2,3,..." 
   [REBOOT=RebootMode] [NODE="SysA"]
   ```

**Uninstall command examples**

The following uninstall command example completely uninstalls the VCS client components, and reboots the system at the end of the uninstall process:

```
Setup.exe /s Solutions=7 Install_mode=5 Reboot=0
```

The following uninstall command example completely uninstalls the VCS server components, and reboots the system at the end of the uninstall process:

```
Setup.exe /s Solutions=6 Install_mode=5 Reboot=1
```
Uninstalling Veritas Cluster Server

Uninstalling from the command line
Upgrading Veritas Cluster Server

This chapter includes the following topics:

■ Upgrading the VCS cluster to VCS 5.1 SP2
■ Upgrading an Exchange server cluster
■ Upgrading a SQL server cluster
■ Upgrading an Oracle cluster
■ Upgrading the Microsoft service packs

Upgrading the VCS cluster to VCS 5.1 SP2

This section describes the tasks to be carried out when upgrading to Veritas Cluster Server 5.1 SP2.

Note: Before upgrading to VCS 5.1 SP2, verify the version of Snapdrive installed. If you have Snapdrive 3.2 or 4.x installed and you upgrade to VCS 5.1 SP2, all the wizards that were working before the upgrade, will stop working. You must upgrade to VCS 5.1 SP2 first and then upgrade the Snapdrive installation to version 6.0 or above.

Before you upgrade the cluster

Ensure that you perform the pre-upgrade tasks as mentioned in the following sections, before you proceed with the actual upgrade steps.
General preparations

When upgrading the product, perform the following general pre-upgrade tasks:

■ Ensure that your cluster nodes have version 5.0RP1a or higher of VCS already installed. The previously installed versions of VCS must meet this minimum product version, which the product installer checks before it upgrades. If your current installation does not meet the minimum level required by the installer, you must manually apply the appropriate product upgrades to meet the minimum product level required before proceeding with the installer. You can get the intermediate versions of the products on the Symantec Support site:

■ Back up all your data.

■ Back up the system state.

■ Check the hardware requirements for the software upgrade.

■ Check to see if you need to update the Microsoft Active Directory to support the upgrade software.

■ Test the system after each upgrade, especially after applying product upgrades to meet the minimum version required. An incremental upgrade eases the troubleshooting process.

Saving and closing the cluster configuration

Before starting the upgrade process, use the VCS Java Console to "save and close" the VCS configuration. This operation involves saving the latest configuration to disk and changing the configuration state to read-only mode. You must also stop VCS before attempting the upgrade process.

To save and close the cluster configuration

◆ Perform one of the following tasks:
  ■ From the VCS Java Console, click Save and Close Configuration on the Cluster Explorer toolbar.
  ■ From the command prompt, type the following command.

C:\>haconf -dump -makero

Taking the service groups offline

Take all service groups offline before the upgrade.

Note: This task is applicable only in case of parallel upgrade.
To take the service groups offline

1. From the command prompt, type:

   C:\> hagrp -offline group_name -sys system_name

   where group_name is the name of the service group and system_name is the node on which the group is online.

2. Repeat this command for all service groups that are online.

Closing VCS clients

Exit all instances of the Cluster Manager (Java Console) before the upgrade. To close VCS clients, click File > Logout from the Cluster Manager (Java Console) and then click File > Exit on the Cluster Monitor window.

About upgrading VCS while in co-existence with Veritas NetBackup

If you are running Veritas NetBackup™ version 6.0 or 6.5 on systems where you are upgrading VCS then you must shut down the OpsCenterServer service before an upgrade.

Both NetBackup and VCS share the same AT broker and client, and for this reason the OpsCenterServer service must be shut down before an upgrade.

Changing the driver signing options

When upgrading on systems running Windows Server 2003, you must set the Windows driver signing option to ignore software authentication warning messages.

To change the driver signing options

1. Open the Control Panel and click System.
2. Click the Hardware tab and click Driver Signing.
3. In the Driver Signing Options dialog box, note the current setting, and select Ignore.
4. Click OK.
5. Repeat on each cluster node.

Note: If you do not change these options, the installer rejects the node at validation and halts the upgrade. After you complete the upgrading, you should reset the driver signing options to their previous state.
Upgrading the cluster

Use the VCS product installer to upgrade the cluster. You can upgrade the product on multiple remote nodes.

When upgrading on multiple nodes, ensure that all the nodes have the same platform type (x86 or x64). The Windows operating systems can be different though.

During the upgrade, ensure that you select all the installed options. If you do not want to include any of the installed option in the upgraded cluster, uninstall the same from the cluster before upgrading. Also, when upgrading multiple nodes, the selected options should be the same on all the nodes. However, if a superset of options is selected, then the upgrade proceeds as normal and all selected options (superset of options) are installed on all the nodes.

Note: The installer removes all hotfixes installed on the existing version before performing the upgrade. Some of those hotfixes are already part of this service pack. However, after performing the upgrade you may want to re-install the hotfixes that are not included in the service pack. Please refer to the following technote for a list of hotfixes that are not part of this service pack:
http://entsupport.symantec.com/docs/358408

You can upgrade the cluster in any one of the following ways:

- Parallel upgrade
  See “About the parallel upgrade” on page 48.

- Rolling upgrade
  See “About the rolling upgrade” on page 51.

About the parallel upgrade

To perform a parallel upgrade you must bring the application service groups offline on all the cluster nodes and then run the product installer to begin the upgrade. This requires a considerable amount of downtime for the clustered applications.

Additionally, ensure that you have performed all the pre-upgrade tasks.
See “Before you upgrade the cluster” on page 45.

Performing a parallel upgrade

Follow the steps below to upgrade VCS parallely on all the cluster nodes.
To upgrade VCS

1. Insert the DVD containing the installation software into your system's disc drive or download the installation software from the Symantec website.

2. Allow the autorun feature to start the installation or from Windows Explorer, navigate to the root directory of the Veritas Cluster Server installation media and double-click `Setup.exe`.

3. Under Install Veritas Cluster Server, click **Complete/Custom**. The Complete/Custom installation installs server components and optional client components. Click **Administrative Console** if you wish to install only the client components. This will install the VCS Java Console.

4. On the Welcome panel, review the welcome message and click **Next**.

5. On the License Agreement panel, review the terms of license agreement and select **I accept the terms of License Agreement**. click **Next**.

6. On the License panel, select **Enter license key(s)**, type the license key, click **Add**, and then click **Next**. The License key details section displays more information about the selected key.

   The License key details section displays more information about the selected key.

   If you do not have a license key, select **Use embedded evaluation license key** and click **Next**.

   To delete a license key, select the key from the key list and click **Remove**.

7. On the Option Selection panel, select the appropriate product options and click **Next**.

   If any previous VCS agents and options are installed on the node, make sure you select the same agents and options while upgrading. If you do not want to include the agents and options in the upgraded cluster, uninstall them from the cluster before proceeding.

8. On the System Selection panel, add the systems on which you want to install the product. You can perform this in one of the following ways:

   - In the System Name text box, manually type the system name and click **Add**.
   - Alternatively, browse to select the systems.

   On the Select Systems panel, the systems that belong to the domain in which you have logged in are listed in the Available Systems list. Select one or more systems and click the right arrow to move them to the Selected Systems list. Click **OK**.
Once you add or select a system, the wizard performs the verification checks and notes the verification details. To review the details, click the corresponding information icon.

The installation directory used during the installation is selected by default.

After the installer validates the systems for the installation, click **Next**.

Note that the installer fails to proceed with the installation, unless all the selected systems have passed the verification checks and are ready for installation. In case the verification checks have failed on any of the system, review the details and rectify the issue. Before you choose to proceed with the installation click **Re-verify** to re-initiate the verification checks for this system.

On the Pre-upgrade Summary panel, review the summary, select **Automatically reboot systems after installer completes the operation** to reboot the systems after the installation is complete. Click **Next**.

On the Pre-upgrade Tasks panel, review the progress of pre-upgrade tasks and click **Next**, after the tasks are complete on all the systems.

If the pre-upgrade tasks fail on any of the system, click **Retry** to run the tasks on the system again. Click **Retry All** to run the tasks on all the systems again.

Note that the installer fails to proceed with the installation unless the pre-upgrade tasks are complete on all the systems.

If the tasks continue to fail even after attempting to rectify and retry to run the tasks, you may have to remove the affected systems from the list to continue with the installation.

On the Installation panel, review the progress of installation and click **Next** when the installation is complete.

If an installation is not successful on any of the systems, the status screen shows a failed installation. If a security alert asks you to accept the Veritas driver software, click **Yes**.
13 On the Post-upgrade Summary panel, review the installation result and click Next.

If the installation has failed on any of the system, refer to the log file for details.

14 On the Finish panel, click Finish.

If you had chose to initiate the auto reboot, a confirmation message to reboot the local system appears. Click Yes to reboot immediately or No to reboot later.

In case you had not selected to initiate the auto reboot, ensure that you manually reboot these systems.

About the rolling upgrade

Perform a rolling upgrade to minimize the downtime for the cluster. Depending on the situation, you can calculate the approximate downtime as follows:

You can fail over all your service groups to the nodes that are up. Downtime equals the time that is taken to offline and online the service groups.

You have a service group that you cannot fail over to a node that runs during upgrade. Downtime for that service group equals the time that is taken to perform an upgrade and restart the node.

Planning for rolling upgrade

Plan out the movement of the service groups from node-to-node to minimize the downtime for any particular service group.

Some rough guidelines include:

- Split the cluster in half. If the cluster has an odd number of nodes, calculate \((n+1)/2\), and start the upgrade with the even number of nodes.
- Split the cluster so that your high priority service groups remain online during the upgrade of the first subcluster.

Rolling upgrade limitations

The following limitations may apply during the phased upgrade:

- While you perform the upgrades, do not add or remove service groups to any of the nodes.
- Depending on your configuration, you may find that you cannot upgrade multiple nodes at the same time. You may only be able to upgrade one node at a time.
For very large clusters, you might have to repeat these steps multiple times to upgrade your cluster.

Overview of tasks
The high level tasks for a rolling upgrade include:

- Move all the service groups from the first subcluster to the second subcluster. In case of a small cluster you may move the service groups to the active node and upgrade the passive nodes first.
- Perform the pre-upgrade tasks on the first subcluster or the active node. See “Before you upgrade the cluster” on page 45.
- Run the installer to upgrade the first subcluster or the active node.
- Get the second subcluster or the active node ready for upgrade.
- Activate the first subcluster or the passive nodes.
- Run the installer to start the upgrade on the second subcluster or the active node.
- Activate the second subcluster or the upgraded active node.

Performing a rolling upgrade
Follow the steps below to upgrade VCS, using the rolling upgrade process. The following procedure considers a two node cluster with NODE1 and NODE2. Where, NODE1 is an active node and NODE2 is a passive node.

To perform a rolling upgrade

1. Ensure that you have saved the cluster configuration and changed its state to read-only mode.

2. Using the command prompt perform the following steps on NODE1:
   - Stop the VCS processes.
     hastop -all -force
   - Stop the LLT driver.
     net stop llt
     A confirmation message to stop the following dependent service appears. Enter 'Y' to stop the services.
     - Veritas VCSComm Startup
     - Veritas GAB Service
3 On NODE2, run the VCS product installer and follow the wizard steps to upgrade VCS and other installed options. This stops all the VCS services. Ensure that you reboot the node after the installation is complete. See “To upgrade VCS” on page 49.

4 On NODE1, start the vcscomm service.
```
net start vcscomm
```

5 On NODE2, check the status of HAD.
```
hasys -state
```
When HAD enters a running state, stop it using the following command:
```
hastop -all
```

6 Perform the following on NODE1.
   - Start HAD
     ```
hastart
```
   - Check the status of the application service groups.
     ```
hagrp -state
```
     Once the application service group is fully probed as 'online', bring it offline, using the VCS Cluster Manager (Java Console).
   - Stop HAD
     ```
hastop -local
```

7 Perform the following on NODE2.
   - Start HAD
     ```
hastart
```
   - Using the VCS Cluster Manager (Java Console), bring the application service groups online
   - Stop HAD
     ```
hastop -all -force
```
   - Stop LLT driver
     ```
net stop llt
```
     A confirmation message to stop the following dependent service appears. Enter 'Y' to stop the services.
   - Veritas VCSComm Startup
   - Veritas GAB Service
8 On NODE1, run the VCS product installer and follow the wizard steps to upgrade VCS and the installed options. This stops all the VCS services. After the upgrade is complete, ensure that you reboot the node.

9 Start HAD on all the nodes. From any one node run the following command:

```
hastart -all
```

10 Ensure that all the service groups are probed as online.

After you upgrade the cluster to 5.1 SP2

Perform the following after you upgrade the cluster to 5.1 SP2:

**Resetting the driver signing options**

After completing the installation sequence, reset the drive signing options on each computer.

**Resetting the driver signing option procedure**

1 Open the Control Panel, and click **System**.

2 Click the **Hardware** tab and click **Driver Signing**.

3 In the Driver Signing Options dialog box, reset the option to **Warn** or **Block**.

4 Click **OK**.

5 Repeat this procedure for each computer.

**Bringing the print share service group online after the upgrade**

**Note:** You need not perform this task if you are upgrading from VCS 5.1 SP1.

For VCS 5.1 SP2, the PrintSpool agent (for VCS) has been enhanced to meet scalability and performance requirements. The PrintSpool agent no longer depends on the RegRep agent for operation. The dependency between the PrintSpool and the RegRep resource in a print share service group has been eliminated.

This affects print share service groups configured in earlier versions of VCS. If you have configured a print share and you upgrade VCS, then the existing print share service group will fail to come online, after the upgrade.

After the upgrade is complete, you must run the Print Share Configuration Wizard to modify the print share service group. This will allow the wizard to make the required changes to the service group configuration.
Note: In case of an upgrade, do not add or remove any resources, or modify any other attributes in the print share service group for the first time you run the Print Share Configuration Wizard to modify the service group.

Before you modify the existing print share service group:

- Make sure that the VCS engine (HAD) is running on the cluster node.
- Mount the drives or LUNs that contain the spooler and the registry replication directories on the system on which you will run the wizard.

To modify the print share service group after an upgrade

1. Start the Print Share Configuration Wizard. (Start > All Programs > Symantec > Veritas Cluster Server > Configuration Tools > Print Share Configuration Wizard)
2. Read the information on the Welcome panel and click Next.
3. On the Wizard Options panel, click Modify service group, select your existing print share service group, and then click Next.
4. Click Next on the subsequent wizard panels and complete the wizard steps. You can now bring the printshare service group online.

Importing the VCS Management Pack

This rollup patch contains fixes for the VCS Management Pack. If you have deployed the VCS Management Pack for Microsoft Operations Manager 2005 in your cluster environment, you can re-import the updated VCS Management Pack after installing the rollup patch.

The updated VCS Management Pack is included with the rollup patch software. Import the appropriate VCS Management Pack (.akm file) using the MOM 2005 SP1 Administrator Console.

While importing the management pack, ensure that you select the Update existing Management Pack option in the Management Pack Import/Export Wizard.

Changing the type definition default values

The cluster type definitions are reset to their default values after the upgrade. Refer to the backup copy of the types.cf file. Use the Cluster Manager (Java Console) to change the type definition default values with the values from the types.cf backup file.
Note: Do not replace the types.cf file with the backup copy after the upgrade. The backup copy must be used only as a reference for the customized type definition values in the cluster.

Removing the VRTSWebApp resource from the configuration

Support for the VCS Cluster Management Console (Single Cluster Mode) is discontinued in 5.1 SP2. The VCS VRTSWebApp agent has been deprecated and is uninstalled during the upgrade. Also, the VCS Cluster Configuration Wizard (VCW) no longer provides the option to configure the Cluster Manager service components.

If VRTSWebApp resource is configured in ClusterService group, after upgrading to 5.1SP2 the resource fails to get probed and the ClusterService group fails to come online in the cluster. You must manually delete the VRTSWebApp resource from the ClusterService group. Use the Cluster Manager (Java Console), the command line (hares -delete), or the Veritas Operations Manager (VOM) to remove the resource.

Upgrading an Exchange server cluster

This section describes the upgrade scenarios for upgrading to VCS 5.1 SP2 in an Exchange 2003 or Exchange 2007 cluster.

For details on upgrading to VCS 5.1 SP2,

See “Upgrading the VCS cluster to VCS 5.1 SP2” on page 45.

During the upgrade you may want to update Exchange with a service pack after upgrading VCS. For information on updating Exchange service packs,

See “Upgrading to Microsoft Exchange Server 2007 SP3 in a VCS environment” on page 78.

See “Upgrading to Microsoft Exchange 2003 SP2 in a VCS environment” on page 77.

See “Upgrading from Microsoft Exchange 2010 to Exchange 2010 SP1 in a VCS environment” on page 81.

Upgrade scenarios

Table 4-1 table presents possible scenarios for upgrading to a VCS 5.1 SP2 cluster with Microsoft Exchange.
Table 4-1 Upgrade matrix for Exchange cluster

<table>
<thead>
<tr>
<th>Upgrade from cluster configuration...</th>
<th>Upgrade to cluster configuration...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCS — 5.0RP1a, 5.0 RU1, 5.1, 5.1AP1, 5.1SP1</td>
<td></td>
</tr>
<tr>
<td>Operating System — Windows Server 2003</td>
<td></td>
</tr>
<tr>
<td>Exchange Server — 2003</td>
<td></td>
</tr>
<tr>
<td>VCS — 5.1SP2</td>
<td></td>
</tr>
<tr>
<td>Operating System — Windows Server 2003 (SP1, SP2, R2)</td>
<td></td>
</tr>
<tr>
<td>Exchange Server — 2003 (SP2)</td>
<td></td>
</tr>
</tbody>
</table>

| VCS — 5.0RP1a, 5.0 RU1, 5.1, 5.1AP1, 5.1SP1  |
| Operating System — Windows Server 2003 (x64 only)  |
| Exchange Server — 2007               |
| VCS — 5.1SP2                         |
| Operating System — Windows Server 2003 (SP1, SP2, R2) x64 only  |
| Exchange Server — 2007 (SP1, SP2, SP3)         |

**Upgrading a SQL server cluster**

This section provides information about upgrading to VCS 5.1 SP2 in a SQL Server cluster.

During the cluster upgrade you may also want to upgrade SQL Server.

See “Upgrading from Microsoft SQL Server 2000 to SQL Server 2005” on page 58.

See “Upgrading from Microsoft SQL Server 2000 or 2005 to SQL Server 2008 or SQL Server 2008 R2” on page 60.

Additionally, you may want to update SQL Server with a service pack. For information on upgrading SQL server service packs,

See “Upgrading Microsoft SQL 2000 to SP4 in a VCS environment” on page 82.

See “Upgrading Microsoft SQL 2005 to SP1 in a VCS environment” on page 83.

See “Upgrading Microsoft SQL 2005 to 2005 SP2 or later in a VCS environment” on page 85.

See “Upgrading Microsoft SQL 2008 or 2008 R2 with the latest service packs in a VCS environment” on page 89.

See “Upgrading from Microsoft SQL Server 2008 or SQL Server 2008 SP1 to SQL Server 2008 R2” on page 64.

**Note:** If you are upgrading both Microsoft SQL Server and VCS, then you must upgrade VCS first and then proceed to upgrade SQL Server.
Upgrade scenarios

Table 4-2 presents possible scenarios for upgrading to a VCS 5.1 SP2 cluster with SQL Server.

<table>
<thead>
<tr>
<th>Upgrade from cluster configuration...</th>
<th>Upgrade to cluster configuration...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCS — 5.0RP1a, 5.0 RU1, 5.1, 5.1AP1, 5.1SP1</td>
<td>VCS — 5.1SP2</td>
</tr>
<tr>
<td>Operating System — Windows Server 2003</td>
<td>SQL Server — 2005 (including SP2), 2008 (including SP1 and R2)</td>
</tr>
<tr>
<td>SQL Server — 2000 SP4</td>
<td></td>
</tr>
<tr>
<td>VCS — 5.0RP1a, 5.0 RU1, 5.1, 5.1AP1, 5.1SP1</td>
<td>VCS — 5.1SP2</td>
</tr>
<tr>
<td>Operating System — Windows Server 2003</td>
<td>SQL Server — 2005 SP2, 2008 (including SP1 and R2)</td>
</tr>
<tr>
<td>SQL Server — 2000 SP4, 2005</td>
<td></td>
</tr>
<tr>
<td>VCS — 5.1AP1, 5.1SP1</td>
<td>VCS — 5.1SP2</td>
</tr>
<tr>
<td>Operating System — Windows Server 2003</td>
<td>SQL Server — 2008 SP1, 2008 R2</td>
</tr>
<tr>
<td>SQL Server — 2008</td>
<td></td>
</tr>
</tbody>
</table>

Upgrading from Microsoft SQL Server 2000 to SQL Server 2005

The following steps describe how to upgrade your existing SQL Server 2000 cluster to SQL Server 2005. Complete these steps on all the cluster nodes that are part of the SQL service group, one node at a time.

At a high level, upgrading to SQL Server 2005 involves the following tasks:

- Upgrade SQL Server on the first node
- Upgrade SQL Server on each additional node
- Create the SQL Server 2005 service group
To upgrade SQL Server on the first node

1. Using the VCS Cluster Manager (Java Console), on any one of the cluster node on which you want to upgrade SQL Server, take all the SQL Server 2000 service group resources (except the storage resources) offline and delete them.

   If the resources are already offline, bring only the storage resources online. To bring the storage resources online, from the VCS Cluster Manager (Java Console), right-click each of the storage resource and select **Online**. Click **Yes** in the confirmation pop-up to bring the resource online.

2. Take a backup of the SQL Server 2000 data directories from the shared disk and store them in a temporary location.

   You will need the backed-up directories while upgrading SQL Server on the additional failover nodes.

3. Launch the Microsoft SQL Server 2005 installer and proceed through the installation process.

   Make sure that you select the option to upgrade the existing instance(s) when prompted to do so. This action automatically places the data files in the proper location.

4. Reboot the node if requested to do so when the installation completes.

5. Take the service group offline on the first node, if you did not reboot.

   (Rebooting automatically takes the service group offline.)

Once you have completed the upgrade procedure on the first node, you must perform the following steps on each additional node in the cluster.

To upgrade SQL Server on each additional node

1. Bring the SQL Server 2000 service group storage resources online. From the VCS Cluster Manager (Java Console), right-click each of this resource and select **Online**. Click **Yes** in the confirmation pop-up to bring the resource online.

2. From the shared disks, delete the original RegRep folder, if any, and rename the SQL Server 2000 data directories.

3. Copy the backed-up SQL Server 2000 data directories from the temporary location to the shared disks.

   The backed-up directories are the same that you had backed up earlier while upgrading SQL Server on the first cluster node.
Launch the Microsoft SQL Server 2005 installer and proceed through the installation process.

Make sure that you select the option to upgrade the existing instance(s) when prompted to do so. This action automatically places the data files in the proper location.

Refer to your Microsoft SQL Server 2005 documentation for more detailed instructions on installing Microsoft SQL Server.

Reboot the node if requested to do so when the installation completes.

Take the entire service group offline, if you did not reboot the node. (Rebooting automatically takes the service group offline.)

Note: If there are no additional nodes to upgrade, you need not offline the service group.

Once you have completed upgrading all of the nodes in the SQL Server cluster, continue with creating the service group.

To create the SQL Server 2005 service group

1. On the last node, ensure that only the storage resources (from the SQL Server 2000 service group) are online. If offline, from the VCS Cluster Manager (Java Console), right-click each of this resource and select Online.

2. From the Java Console, delete the existing SQL Server 2000 service group (from the treeview). Right-click the service group and select Delete. Click Yes when asked to confirm if you want to delete the service group.

3. Create the SQL Server 2005 service group using the SQL Server Configuration Wizard. Click Start > All Programs > Symantec > SQL Server Configuration Wizard.

4. Test switch the service group to another node in the cluster. Right-click the service group in treeview, select Switch To, and select any additional node in the cluster.

Upgrading from Microsoft SQL Server 2000 or 2005 to SQL Server 2008 or SQL Server 2008 R2

The following steps describe how to upgrade your existing clustered SQL Server 2000 or SQL Server 2005 setup to SQL Server 2008 or SQL Server 2008 R2. Complete these steps on all the cluster nodes that are part of the SQL service group, one node at a time.
**Note:** These steps are applicable only if you already have SQL Server 2000 or SQL Server 2005 set up in your cluster environment.

At a high level, upgrading to SQL Server 2008 or 2008 R2 involves the following tasks:

- Upgrade SQL Server on the first cluster node.
- Upgrade SQL Server on each additional failover node.
- In case of a Disaster Recovery configuration, repeat the SQL upgrade procedures on the nodes at the secondary site. First upgrade the first cluster node at the DR site, and then the additional failover nodes.
- Delete the existing SQL Server 2000 or 2005 service group, including the service group at the DR site, if applicable.
- Create a SQL Server 2008 or SQL Server 2008 R2 service groups, using the SQL Server 2008 Configuration Wizard. In case of a DR setup, create a service group at the secondary site also.

To configure a new HA and DR environment for SQL Server 2000 or SQL Server 2005, refer to the *Veritas Cluster Server Implementation Guide for Microsoft SQL*.

To configure a new HA and DR environment for SQL Server 2008 or SQL Server 2008 R2, refer to the *Veritas Cluster Server Implementation Guide for Microsoft SQL Server 2008*.

**Note:** In case of a Disaster Recovery setup, you must first upgrade SQL on the cluster nodes at the primary site and then proceed with the nodes at the secondary site. You must follow the same upgrade sequence at both sites, upgrade first node and then the additional nodes, as described in the procedures in this section.

Ensure that you perform the following before the upgrade:

- Take a backup of the SQL databases.
- In case of a Disaster Recovery environment, ensure that the databases on the primary and secondary sites are synchronized and then stop the replication between the sites.
- Ensure that you have installed VCS 5.1 SP2 for Windows on all the SQL service group cluster nodes that you wish to upgrade. See “About installing VCS” on page 27.
- Make a note of the SQL virtual server name and all the IP addresses configured at both the primary and the secondary site, for the SQL setup in the DR environment. You will need these details later.
Upgrading SQL on the first cluster node

These steps assume a single SQL Server instance configured in a two-node cluster configuration.

To upgrade SQL Server on the first cluster node

1. On any one of the cluster node on which you want to upgrade SQL Server, take all the SQL Server 2000 or SQL Server 2005 service group resources (excluding the storage resources) offline and delete the same. If the resources are already offline, bring the storage resources online. To bring the resource online, from the VCS Cluster Manager (Java Console), right-click each of the resource and select Online. Click Yes in the confirmation pop-up to bring the resource online.

2. Take a backup of the SQL Server 2000 or SQL Server 2005 database from the shared disk and store them in a temporary location. You will need the backed-up directories while upgrading SQL Server on the additional failover nodes.

3. Launch the Microsoft SQL Server 2008 installer and install SQL Server 2008 on the node. Make sure that you select the option to upgrade the existing SQL Server instance(s), when prompted to do so. The SQL Server 2008 installer then automatically places the SQL data files in the appropriate location. Refer to the Microsoft SQL Server 2008 documentation for instructions.

4. Take the entire service group offline on the node.

This completes the upgrade steps on the first cluster node. Proceed to upgrading SQL on the additional failover nodes.

Upgrading SQL on the additional failover node

Perform the following steps on each additional failover node that is part of the SQL service group.

To upgrade SQL Server on the additional node

1. Bring the storage resources online. From the VCS Cluster Manager (Java Console), right-click each of the resource and select Online. Click Yes in the confirmation pop-up box to bring the resource online.

2. Rename the SQL Server data directories on the shared disks. These directories are updated when SQL Server is installed on the first node. You can also delete these directories, if desired.
3 Copy the backed-up SQL Server 2000 or SQL Server 2005 data directories from the temporary location to the shared disks.

The backed-up directories are the same that you had backed up earlier while upgrading SQL Server on the first cluster node.

4 Launch the Microsoft SQL Server 2008 installer and install SQL Server 2008 on the node. Make sure that you select the option to upgrade the existing SQL Server instance(s), when prompted to do so. The SQL Server 2008 installer then automatically places the SQL data files in the appropriate location.

Refer to the Microsoft SQL Server 2008 documentation for instructions.

5 Take the entire service group offline on the node.

---

**Note:** If there are no additional nodes for upgrade, you need not offline the service group.

This completes the upgrade steps on the additional failover node. Delete the existing SQL Server 2000 or 2005 service group and proceed to create SQL Server 2008 or 2008R2 service group in the cluster.

### Create SQL Server 2008 or 2008 R2 service group

From the last upgraded node, run the SQL Server 2008 Configuration Wizard to configure the SQL 2008 or 2008 R2 service group. Refer to *Veritas Cluster Server Implementation Guide for Microsoft SQL Server 2008* for instructions.

**Note:** In case of a Disaster Recovery setup, repeat these steps on the first cluster node at the secondary site and then reconfigure the DR components. Refer to the *Veritas Cluster Server Implementation Guide for Microsoft SQL Server 2008* for instructions.

### To create the SQL Server 2008 or 2008 R2 service group

1 Rename the Registry (RegRep) directory, if present, on the shared disk.

2 Create the SQL Server 2008 or 2008 R2 service group using the SQL Server 2008 Configuration Wizard.

Refer to *Veritas Cluster Server Implementation Guide for Microsoft SQL Server 2008* for detailed instructions on how to create the service group using the SQL Server 2008 Configuration Wizard.
3 After creating the SQL Server service group, verify the configuration by switching the service group to another node in the cluster.

4 Delete the RegRep directory that you renamed in the first step.

Upgrading from Microsoft SQL Server 2008 or SQL Server 2008 SP1 to SQL Server 2008 R2

The following steps describe how to upgrade your existing SQL Server 2008 cluster to SQL Server 2008 R2. Complete these steps on all the cluster nodes that are part of the SQL service group, one node at a time.

**Note:** These steps are applicable only if you already have SQL 2008 set up in a VCS 5.1 SP2 for Windows cluster environment.

At a high level, upgrading to SQL Server 2008 R2 involves the following tasks:

- Ensure that you have installed VCS 5.1 SP2 for Windows on all the SQL service group cluster nodes that you wish to upgrade.
- Take a backup of the SQL databases.
- Upgrade SQL Server on the first cluster node.
- Upgrade SQL Server on each additional failover node.
- In case of a Disaster Recovery configuration, ensure that the databases on the primary and secondary sites are synchronized and then proceed to upgrade the cluster.

You can upgrade the cluster using one of the following methods:

- Adding a temporary disk and creating the volumes similar to that on the primary site.
  
  To upgrade the cluster using this method, perform the set of pre-upgrade tasks and then proceed to upgrade the cluster on both the sites. You must follow the same upgrade sequence parallel at both sites, upgrade first node and then the additional nodes, as described in the procedures.
  
  See “Preupgrade tasks for disaster recovery” on page 65.

- Deleting the service group and re-creating the setup.
  
  Follow this method only if the data size is small. After you re-create the service groups and setup replication across the two sites, the entire data will be replicated. This involves a considerable amount of time.
  
  See “Deleting the service group and re-creating the setup” on page 69.

- Run the SQL Server 2008 configuration wizard in the modify mode, to modify the SQL Server 2008 service group.

Preupgrade tasks for disaster recovery

Before you proceed to upgrade the cluster nodes in case of a disaster recovery setup, ensure that you perform the following tasks on the secondary site for the SQL instances you want to upgrade.

■ Freeze the service group using the VCS Cluster Manager (Java Console).

■ Obtain the drive letter on which the system database and the analysis service reside, using the following command:

```
hadiscover -discover SQLServer2008 StartUpParams:INSTANCE2K8
```

The sample output is similar to the following:

```
<Discovery>
 <Attr_Name>
  StartUpParams:INSTANCE2K8
 </Attr_Name>
 <Discover_value>
  <Scalar_value>
   SQLDataPath: E:\Program Files\Microsoft SQL Server\MSSQL10.INSTANCE2K8\MSSQL\DATA\ 
  </Scalar_value>
  </Discover_value>
 <Discover_value>
  <Scalar_value>
   SQLErrLogPath: E:\Program Files\Microsoft SQL Server\MSSQL10.INSTANCE2K8\MSSQL\LOG\ERRORLOG
  </Scalar_value>
  </Discover_value>
 <Discover_value>
  <Scalar_value>
   OLAPDataPath: E:\Program Files\Microsoft SQL Server\MSAS10.INSTANCE2K8\OLAP\Data
  </Scalar_value>
  </Discover_value>
</Discovery>
```

■ Attach a temporary disk and create a volume with the drive letter same as that for the instance on which the system database resides.
Note: If you are upgrading more than one instance having system database path and the OLAP data path on separate volumes, you must complete the upgrade of each instance on both the sites and then proceed to upgrade the next instance.

- Review the SQLDataPath, SQLErrLogPath and the OLAPDataPath directory and create the same on the temporary disk.

Note: In case the directory path exists on different volumes, ensure that you create similar volumes and then create the required directory paths.

- Copy the following files from the primary site to the data path created on the secondary site.
  - master.mdf
  - mastlog.ldf
  - model.mdf
  - modellog.ldf
  - MSDBData.mdf
  - MSDBLog.ldf
  - tempdb.mdf
  - templog.ldf

**Upgrading SQL Server on the first cluster node**

These steps assume a single SQL Server instance configured in a two-node cluster configuration.
To upgrade SQL Server on the first cluster node

1. On the node on which the SQL service group is online, take all the resources (excluding the storage resources) offline.

   From the VCS Cluster Manager (Java Console), right-click the resource and select Offline. Click Yes in the confirmation pop-up box to take the resource offline.

2. Take a backup of the SQL Server 2008 directories from the shared disk and store them in a temporary location.

   You will need the backed-up directories while upgrading SQL on the additional failover nodes, later.

3. Delete the RegRep resource.

4. Freeze the SQL service group using the VCS Cluster Manager (Java Console).

   From the VCS Cluster Manager (Java Console), right-click the SQL Server service group in tree view on the left pane, and click Freeze > Persistent.

5. Launch the Microsoft SQL Server 2008 R2 installer and install SQL Server 2008 R2 on the node. Make sure that you select the option to upgrade the existing SQL Server instance(s), when prompted to do so. Also, ensure that the instance name or id is the same on all the cluster nodes.

   The SQL Server 2008 R2 installer then automatically places the SQL data files in the appropriate location.

   Refer to the Microsoft SQL Server 2008 documentation for instructions.

6. Unfreeze and then take the SQL Server service group offline. From the VCS Cluster Manager (Java Console), right-click the SQL Server service group in tree view on the left pane and click Unfreeze, and then take the entire service group offline on the node.

   This completes the upgrade steps on the first cluster node. Proceed to upgrading SQL on the additional failover nodes.

Upgrading SQL on additional failover node

Perform the following steps on each additional failover node that is a part of the SQL service group.
To upgrade SQL Server on the additional node

1  Bring the storage resources online. From the VCS Cluster Manager (Java Console), right-click the resource and select Online. Click Yes in the confirmation pop-up box to bring the resource online.

2  Delete the original RegRep folder and rename the SQL Server data directories on the shared disks. These directories are updated when SQL Server 2008 R2 is install on the first node. You can also delete these directories, if desired.

3  Copy the backed-up SQL Server 2008 databases from the temporary location to the shared disks. The backup directories are the same that you had backed up earlier while upgrading SQL on the first cluster node.

4  Freeze the SQL service group.
   From the VCS Cluster Manager (Java Console), right-click the SQL Server service group in tree view on the left pane and click Freeze > Persistent.

5  Launch the Microsoft SQL Server 2008 R2 installer and install SQL Server 2008 R2 on the node. Make sure that you select the option to upgrade the existing SQL Server instance(s), when prompted to do so. The SQL Server 2008 R2 installer then automatically places the SQL data files in the appropriate location.
   Refer to the Microsoft SQL Server 2008 documentation for instructions.

6  From the VCS Cluster Manager (Java Console), right-click the SQL Server service group in tree view on the left pane and click Unfreeze, and then take the entire service group offline on the node.

Note: If there are no additional nodes for upgrade, you need not offline the service group.

This completes the upgrade steps on the additional failover node. Proceed to modify the SQL Server service group configuration.

Modifying the SQL Server 2008 service group configuration

From the last upgraded node, run the SQL Server 2008 Configuration Wizard in modify mode to modify the SQL Server 2008 service group configuration.

Note: In case of a Disaster Recovery setup, repeat these steps on the first cluster node at the secondary site and then reconfigure the DR components.

Refer to Veritas Cluster Server Implementation Guide for Microsoft SQL Server 2008 for instructions.
To modify the SQL Server configuration

1. Rename the Registry (RegRep) directory on the shared disk.

2. On the first cluster node, bring the storage resources of the SQL service group, online.

3. Run the SQL Server 2008 wizard in the modify mode and follow the wizard steps.
   - When asked for, provide the location for the RegRep resource. This creates a new RegRep for SQL Server 2008 R2.
   - Refer to the Veritas Cluster Server Implementation Guide for Microsoft SQL Server 2008 for detailed instructions on how to create the service group using the SQL Server 2008 Configuration Wizard.

4. After modifying the SQL Server service group, verify the configuration by switching the service group to another node in the cluster.

5. Delete the RegRep directory that you renamed in the first step.

Deleting the service group and re-creating the setup

Perform these tasks only if you are upgrading the cluster in a disaster recovery setup and have chosen to follow the upgrade by deleting the service group and the re-creating the setup.

- Using the VCS Cluster Manager (Java Console), offline and delete the service group for the instance you want to upgrade, on both the sites.
- Stop the replication between the primary and the secondary site.
- For the selected instance mount the created volumes and LUNs on any one of the cluster node, on both the sites.

Note: Ensure that the instance name and id is the same on all the cluster nodes.

- Launch the Microsoft SQL Server 2008 R2 installer and install SQL Server 2008 R2 on the node. Make sure that you select the option to upgrade the existing SQL Server instance(s), when prompted to do so.
- To upgrade the additional nodes, dismount the volumes on the upgraded node and mount them on the node to be upgraded. Launch the SQL Server 2008 R2 installer to install SQL Server 2008 R2. Repeat this task for each additional node.
- Create the SQL Service group, reconfigure the DR components and the set the required resource dependency.
For details refer to, *Veritas Cluster Server Implementation Guide for Microsoft SQL Server 2008*

**Upgrading an Oracle cluster**

This section describes the upgrade scenarios for upgrading to VCS 5.1 SP2 in an Oracle cluster.

**Note:** If you are upgrading both Oracle and VCS, then you must upgrade VCS first and then proceed to upgrade Oracle.

**Upgrade scenarios**

*Table 4-3* table possible scenarios for upgrading to VCS 5.1 SP2 in an Oracle cluster.

<table>
<thead>
<tr>
<th>Upgrade from cluster configuration…</th>
<th>Upgrade to cluster configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCS – 5.0RP1a, 5.0 RP2, 5.0 RU1, 5.1, 5.1 AP1, 5.1SP1</td>
<td>VCS 5.1SP2</td>
</tr>
<tr>
<td>Operating System – Windows Server 2003</td>
<td>Windows Server 2003 SP1, SP2, R2</td>
</tr>
<tr>
<td>Oracle – 9.0.1, 9.0.2, 9.1x</td>
<td>Oracle 9.2x, 10g R1, 10g R2, 11g R1 (11.1.0.6.0)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Upgrade from cluster configuration…</th>
<th>Upgrade to cluster configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCS – 5.0RP1a, 5.0 RP2, 5.0 RU1, 5.1, 5.1 AP1, 5.1SP1</td>
<td>VCS 5.1 SP2</td>
</tr>
<tr>
<td>Operating System – Windows Server 2003</td>
<td>Windows Server 2003 SP1, SP2, R2</td>
</tr>
<tr>
<td>Oracle – 10.1, 10.2</td>
<td>Oracle 11g R1 (11.1.0.6.0)</td>
</tr>
</tbody>
</table>

**Upgrading Oracle in a VCS cluster**

This section describes the tasks necessary to upgrade Oracle in a VCS cluster.

**Note:** For information about supported Oracle upgrade paths, refer to your Oracle documentation.
Upgrading the Oracle application
Upgrading Oracle involves the following steps:
- Upgrading the Oracle binaries.
- Upgrading the Oracle database.
Perform the following tasks before upgrading the Oracle database:
- Bring the Oracle service group online.
- Stop HAD using the `hastop -local -force` command.

Additional tasks after upgrading Oracle
Perform the following tasks to configure Oracle in a VCS environment:
- Associate the updated database with the listener for Oracle 10g and 11g.
  See “Associating the updated database with the listener” on page 71.
- Configure the database and listener to use the virtual IP address.
  See “Configuring the database and listener to use the virtual IP address” on page 72.
- Configure Oracle and listener services.
  See “Configuring Oracle and listener services” on page 75.
- Modify the ServiceName attribute for the Netlsnr resource.
  See “Modifying the ServiceName attribute for the netlsnr resource” on page 76.

Associating the updated database with the listener
The following procedures describe how to associate databases with listeners.

Prerequisites to associate databases with listeners
Ensure that the initialization parameter file contains the following entries:
- SERVICE_NAMES (the name of the database service)
- INSTANCE_NAME (the name of the database instance)
These parameters are created during installation or database creation.

Associate the database with the listener
The following procedure associates the database with the listener.
To associate the database with the listener

1. Use one of the following procedures to configure the new attribute listener_alias:

   Run the following SQL command:

   SQL> ALTER SYSTEM SET LOCAL_LISTENER='<listener_alias>' scope=spfile;

   OR

   Add the following entry to the initialization parameter file (pfile or spfile):

   LOCAL_LISTENER = <listener_alias>

2. Define the parameter listener_alias. If your Oracle configuration uses the file tnsnames.ora, edit the file as instructed below. The default location of tnsnames.ora is %ORACLE_HOME%/NETWORK\ADMIN.

   Add the following to tnsnames.ora file:

   <listener_alias>=
   (DESCRIPTION =
   (ADDRESS=(Protocol=TCP)(HOST=virtual_IP_address)(Port=1521))
   )

3. Stop and restart the database.

   The listener_alias parameter gets appended by the default domain name that is specified in the file sqlnet.ora.

Configuring the database and listener to use the virtual IP address

All databases and listeners configured must use the same virtual IP. Update the Oracle files to set the virtual IP address.

Setting the virtual IP address involves the following tasks:

■ Creating a virtual IP address.
■ Verifying the initialization file settings.
■ Updating the Oracle configuration files.

Use the following procedures to configure the Oracle database and listener.

To create a virtual IP address

1. Open the Network Connections (Start > Settings > Network Connections).
2. Right-click the public network connection to be used and click Properties.
3 Select **Internet Protocol (TCP/IP)** and click **Properties**.

4 Click **Advanced**.

5 In the **IP Settings** tab, click **Add** to add a virtual IP address and subnet mask.

To verify the initialization file settings, if a PFILE is used

1 Open the Registry Editor.
    
    From the **Start** menu, choose **Run**. In the **Open** field, enter `regedit` and click **OK**.

2 Double-click the **ORA_SID_PFILE** registry key at `HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME_ID\`.
    
    The variable `SID` represents the database instance.

3 Verify that the Value data field specifies the correct path at which the initialization file, `init.ora`, is located.

To verify the initialization file settings, if an SPFILE is used

1 Run `sqlplus.exe`.

2 Connect to the database.

3 Verify the following query returns the correct path of the SPFILE.

    ```sql
    select value from v$parameter where name = 'spfile'
    ```
To update the Oracle configuration files

1. In the listener.ora and tnsnames.ora files, change the host name for all the TCP protocol address databases to the virtual IP address that you created.
   Replace
   
   HOSTNAME=machine_name
   
   with
   
   HOSTNAME=virtual_IP_address

2. In the initialization file, change the dispatchers parameter.
   Oracle requires an initialization file, a PFILE or an SPFILE, to start database instances. Choose the appropriate reference depending on the initialization file you use.
   See “Setting the dispatchers parameter in PFILE” on page 74.
   See “Setting the dispatchers parameter in SPFILE” on page 74.

3. Restart the Oracle and listener services.

Setting the dispatchers parameter in PFILE

In the PFILE, set the host name for all TCP protocol address dispatchers to the virtual IP address that you created.

Edit the dispatchers parameter only for the host name and leave the rest of the configuration as it is. Set the value as:

```
dispatchers = '(ADDRESS = (Protocol=TCP)
(HOST=virtual_IP_address)
(any other previously existing entry))'
```

The variable `virtual_IP_address` represents the virtual IP address that you created.

For example:

```
dispatchers = '(ADDRESS = (Protocol=TCP)(HOST=10.210.100.110)
(SERVICE=Data1XDB))'
```

Setting the dispatchers parameter in SPFILE

Use the following steps to set the dispatchers parameter in SPFILE.
To set the dispatchers parameter in SPFILE

1. Convert the SPFILE to PFILE.
2. Modify the PFILE.
   
   See “Setting the dispatchers parameter in PFILE” on page 74.
3. Convert the PFILE to SPFILE.
4. Save the SPFILE to the original location on the shared disk.
   
   Refer to the Oracle documentation for specific information on converting a PFILE or an SPFILE.

Configuring Oracle and listener services

Configuring the Oracle and Listener services involves the following tasks:

- Making the Oracle and Netlsnr services manual.
- Configuring log on properties for Oracle services.

Use the following procedures to configure Oracle and listener services.

To make services manual

1. Open the Services applet (Start > Programs > Administrative Tools > Services).
2. Double-click the service. In the SCM, the following appears:
   
   - Oracle services appear as OracleServiceSID, where SID represents the database instance.
   
   - Listener services appear as OracleOra_HomeTNSListenerName, where Ora_Home represents the Oracle home directory and ListenerName is the name of the listener set during the installation.
3. In the Properties window, click the General tab.
4. From the Startup Type drop-down list, select Manual.
5. Click OK.

To configure the log on properties for oracle services

1. Open the Services applet (Start > Programs > Administrative Tools > Services).
2. Double-click the Oracle service. In the SCM, the names of Oracle services appear as OracleServiceSID, where SID represents the database instance.
3. In the General tab of the Properties window, click Stop to stop the service.
4. Click the Log On tab.
5 Choose This Account.
6 Enter the credentials of the user in whose context Oracle was installed.
7 Click the General tab and click Start to start the service with the new Log On properties. Click OK.

Modifying the ServiceName attribute for the netlsnr resource

Perform the following steps to modify the ServiceName attribute for the Netlsnr resource.

To modify the ServiceName attribute

1 Start HAD. Type the following on the command prompt:

   C:\> hastart

2 Offline the Netlsnr resource. Type the following on the command prompt:

   C:\> hares -offline resource_name -sys system_name

3 Modify the ServiceName attribute for the Netlsnr resource. Type the following on the command prompt:

   C:\> hares -modify resource_name attribute_name attribute_value

   For example, to modify the ServiceName attribute of the Netlsnr resource, Netlsnr_res, type:

   C:\> hares -modify Netlsnr_res ServiceName attribute_value

   where, attribute_value is the name of the listener service in Oracle 9i or 10g versions.

4 Online the Netlsnr resource. Type the following on the command prompt:

   C:\> hares -online resource_name -sys system_name

Upgrading the Microsoft service packs

This section describes how to upgrade Microsoft SQL and Microsoft Exchange servers to their corresponding service packs. The outlined procedures are applicable only if you already have your SQL or Exchange setup in a VCS cluster environment.
Upgrading to Microsoft Exchange 2003 SP2 in a VCS environment

This section describes the procedure to upgrade the Microsoft Exchange 2003 that is already configured in a VCS environment.

Using this procedure you can upgrade Exchange 2003 to Exchange 2003 SP2.

Before upgrading to Microsoft Exchange 2003 SP2, make sure to set the "DetailMonitor" attribute of all "ExchService" type resources to zero.

Perform the following steps to upgrade an Exchange 2003 installation on a node that is part of the Exchange service group. Make sure that all the nodes which are part of the Exchange service group have the same version and service pack level of Microsoft Exchange.

**To upgrade to Microsoft Exchange 2003 SP2**

1. Make sure that you do not mount the Exchange databases on the failover nodes. Bring the Exchange service group online on the node where you are upgrading the Exchange installation.

2. Stop HAD on the node where the service group was brought online. At the command prompt, type:

   ```
   C:\> hastop -local -force
   ```

3. Install Microsoft Exchange 2003 SP2 on the node where the service group was brought online.

   If prompted to install the hotfix for Internet Information Services (IIS) 6.0, refer to the Microsoft Knowledge Base Article: 831464.

4. Start HAD on the node. At the command prompt, type:

   ```
   C:\> hastart
   ```

5. After the Exchange 2003 SP2 installation is complete, take the Exchange service group offline.

6. Restart the Windows Management Instrumentation (WMI) service from the Services snap-in.

7. Repeat step 1 through step 6 on all remaining nodes that are part of the Exchange service group.

8. Update the ExchConfig registry information on every system where Exchange is upgraded.
To update the registry on the local system, navigate to \%vcs_home\%\bin\ExchSetup folder and type the following at the command prompt:

```
Setup.exe /UpdateExchVersion
```

To update the registry on more than one node simultaneously, navigate to \%vcs_home\%\bin\ExchSetup folder and type the following at the command prompt:

```
Setup.exe /UpdateExchVersion system_name1 system_name2...
```

Here, system_name1, system_name2 are the cluster node names.

This completes the upgrade. You can now bring the Exchange service group online in the cluster.

For a disaster recovery environment, repeat this procedure at the secondary (DR) site.

**Upgrading to Microsoft Exchange Server 2007 SP3 in a VCS environment**

This section describes how to upgrade Exchange 2007 to Exchange 2007 SP3, using the Exchange 2007 Upgrade Wizard. It is applicable only if you already have Exchange 2007 set up in a VCS cluster environment.

**Note:** The procedure given below describes how to upgrade Exchange 2007 to Exchange 2007 SP1. This procedure can also be used to upgrade Exchange 2007 SP1 or SP2 to Exchange 2007 SP3.

To configure a new HA and DR environment for Exchange 2007, refer to, *Veritas Cluster Server Implementation Guide for Microsoft Exchange 2007*

Before you proceed to upgrade the Exchange Server service pack, note the following:

- Ensure that the Exchange 2007 service group is offline in the cluster.

- While performing the upgrade the Exchange 2007 Upgrade Wizard renames and then restarts the cluster node. Exit all the other programs before you run the wizard on a cluster node.

Complete the following steps on all cluster nodes that are part of the Exchange 2007 service group, one node at a time.
To upgrade Exchange 2007 to Exchange 2007 SP1

1. On one of the cluster nodes, click Start > All Programs > Symantec > Veritas Cluster Server > Configuration Tools > Exchange 2007 Upgrade Wizard to start the Exchange 2007 Upgrade wizard.

2. Review the information on the Welcome panel and click Next.

3. On the Exchange Virtual Server Selection panel, select the Exchange virtual server that you want to upgrade and then click Next.

   The Summary table provides the details of the Exchange virtual servers in the cluster and their upgrade status on each cluster node.

   ![Exchange Virtual Server Selection](image)

4. The wizard performs the tasks required to set up the VCS environment for the Exchange upgrade. The Tasks table displays the progress of the various tasks. After all the tasks are completed, click Next.
5 Review the information on the Cluster Node Reboot panel and then click **Reboot**. The wizard prompts you to reboot the node. Click **Yes** to reboot the node.

The Exchange virtual server name is temporarily assigned to the cluster node. On rebooting the node, the Exchange 2007 Upgrade Wizard is launched automatically with a message that the Exchange pre-upgrade tasks are complete. Do not click **Continue** at this time. Wait until after the Exchange upgrade is complete.

6 Run the Exchange 2007 SP1 installer to upgrade Exchange 2007 on the node. Type the following at the command prompt:

```bash
<drive letter>:\setup.com /mode:Upgrade
```

*Here* `<drive letter>` *is the drive where the Exchange SP1 installer is located.*

---

**Note:** You can also run Setup.exe to launch the installer GUI for upgrading Exchange. If using the installer GUI, ensure that you do not select any other Exchange 2007 server role. Only the Mailbox server role must be upgraded.

Verify that the upgrade has completed successfully. In case there are errors or if the upgrade has partially succeeded or has failed, resolve the errors and ensure that the upgrade is successful.

Refer to the Microsoft Exchange documentation for more information.

7 Return to the Exchange 2007 Upgrade Wizard and click **Continue**.

If the wizard is not running, click **Start > All Programs > Symantec > Veritas Cluster Server > Configuration Tools > Exchange 2007 Upgrade Wizard** to start the wizard and then click **Next**.

8 The wizard performs the tasks required to set up the VCS environment after the Exchange upgrade. The Tasks table displays the progress of the various tasks. After all the tasks are completed, click **Next**.

9 Review the information on the completion panel and then click **Finish**.

The wizard displays the status of the Exchange virtual server upgrade. The Summary table provides the details of the Exchange virtual servers in the cluster and their upgrade status on each cluster node.
10 Repeat these steps on the remaining cluster nodes. After you have upgraded all the cluster nodes that are configured to host the Exchange virtual server, bring the Exchange 2007 service group online in the cluster.

**Note:** Do not bring the Exchange 2007 service group online until you have completed the upgrade on all the cluster nodes that are part of the service group.

11 For a disaster recovery environment, repeat this procedure at the secondary (DR) site.

**Upgrading from Microsoft Exchange 2010 to Exchange 2010 SP1 in a VCS environment**

This section describes how to upgrade Exchange 2010 to Exchange 2010 SP1. It is applicable only if you already have Exchange 2010 setup in a VCS cluster environment.

Before you proceed to upgrade the Exchange Server service pack, ensure that you have met the following pre-requisites:

- You have met all the necessary pre-requisites for installing Exchange 2010 SP1 on all the cluster nodes where you are upgrading Exchange. For details refer to Microsoft documentation.

- Ensure that you have upgraded VCS to 5.1 SP2, on all the cluster nodes. See “Upgrading the VCS cluster to VCS 5.1 SP2” on page 45.

**To upgrade Exchange 2010 to Exchange 2010 SP1**

1 Using the VCS Cluster Manager (Java Console), bring the Exchange service group online.

2 Stop HAD on all the cluster nodes where you want to upgrade the Exchange installation. At the command prompt, type:

```
hastop -local -force
```

3 Launch the Exchange 2010 SP1 installer and install the service pack.

You can install the service pack parallel on all the nodes, where you are upgrading Exchange. In case of disaster recovery, you can simultaneously upgrade both the sites.
Upgrading Microsoft SQL 2000 to SP4 in a VCS environment

This section describes how to upgrade SQL 2000 to SQL 2000 SP4. It is applicable only if you already have SQL 2000 set up in a VCS cluster environment.

Consider the following points before applying Microsoft SQL 2000 SP4 to a production server:

- Review your Microsoft documentation for the requirements for a Microsoft SQL 2000 Server SP4 installation. Make sure that your system meets these requirements.
- Make sure that you have a recent backup of your system and user databases.
- Server down time is required for this procedure.

To install Microsoft SQL 2000 Server SP4

1. From the Cluster Explorer, right-click the SQL Server service group and select Offline on all nodes.
2. On the node where the SQL Server service group was taken offline, online the MountV resource for the shared drive containing the SQL databases (for example, S:\MSSQL$SQL2000).
3. On the shared disk, make a copy of your recent MSSQL data files directory (S:\MSSQL$SQL2000) and rename it, for example to S:\MSSQL$2000.SP3A.
4. From the Cluster Explorer, right-click the SQL Server service group which is now partially online, and select Freeze > Persistent.
5. Install Microsoft SQL 2000 Service Pack 4 on the active node (where the SQL Server service group is online), using the instructions provided by Microsoft.
6. Repeat step 5 for each additional SQL instance in this service group, if you have more than one instance in this service group.
7. From the Cluster Explorer, right-click the SQL Server service group which is still online and select Unfreeze.
8. From the Cluster Explorer, right-click the SQL Server service group and select Offline on the node where it was online.
9. In a Disaster Recovery environment, switch the Replication service group to one of the other additional or failover nodes in this cluster.
10. On the failover node, online the MountV resource for the shared drive containing the SQL databases (for example, S:\MSSQL$SQL2000).
On the shared disk, rename the S:\MSSQL$SQL2000.SP3A directory to S:\MSSQL$SQL2000. If there are additional nodes in this cluster to be updated, copy the S:\MSSQL$SQL2000.SP3A directory to S:\MSSQL$SQL2000 instead of renaming the directory.

From the Cluster Explorer, right-click the SQL Server service group which is now partially online and select **Freeze > Persistent**.

Install Microsoft SQL 2000 Service Pack 4 on the active node (where the SQL Server service group is online), using the instructions provided by Microsoft.

Repeat step 14 for each additional SQL instance in this service group, if you have more than one instance in this service group.

From the Cluster Explorer, right-click the SQL Server service group which is still online and select **Unfreeze**.

From the Cluster Explorer, right-click the SQL Server service group and select **Offline** on the node where it was online.

Repeat step 9 through step 17 on each additional node if more than two SQL 2000 nodes are in use.

For a Disaster Recovery environment, repeat this procedure at the secondary site.

When Microsoft SQL 2000 Server Service Pack 4 has been completely installed on all nodes, test user connectivity to the instances.

Test the SQL Server service group by bringing it online and failing it over from node to node. When testing is complete, the upgrade is complete.

If more than one SQL Server service group is present, repeat this entire procedure for each SQL Server service group.

---

**Upgrading Microsoft SQL 2005 to SP1 in a VCS environment**

This section describes how to upgrade SQL 2005 to SQL 2005 SP1. It is applicable only if you already have SQL 2005 set up in a VCS cluster environment.

Consider the following points before applying Microsoft SQL 2005 Server SP1 to a production server:

- Review your Microsoft documentation for the requirements for a Microsoft SQL 2005 Server SP1 installation.
  
  Make sure that your system meets these requirements.

- Make sure that you have a recent backup of your system and user databases.

- Server down time is required for this procedure.
To install Microsoft SQL 2005 Server SP1

1. From the Cluster Explorer, right-click the SQL Server service group and select **Offline** on all nodes.

2. On the node where the SQL Server service group was taken offline, online the SQL 2005 resource for the shared drive containing the SQL databases.

3. From the Cluster Explorer, right-click the SQL Server service group which is now partially online, and select **Freeze > Persistent**.

4. If a VVR RVG service group is present, verify that it is online on the node where Microsoft SQL 2005 Service Pack 1 is to be installed.

5. Install Microsoft SQL 2005 Service Pack 1 on the active node (where the SQL Server service group is online), using the instructions provided by Microsoft.

6. Repeat step 5 for each additional SQL instance in this service group, if you have more than one instance in this service group.

7. From the Cluster Explorer, right-click the SQL Server service group which is still online and select **Unfreeze**.

8. From the Cluster Explorer, right-click the SQL Server service group and select **Offline** on the node where it was online.

9. On the failover node, online the SQL 2005 resource for the shared drive containing the SQL databases.

10. From the Cluster Explorer, right-click the SQL Server service group which is now partially online and select **Freeze > Persistent**.

11. Install Microsoft SQL 2005 Service Pack 1 on the active node (where the SQL Server service group is online), using the instructions provided by Microsoft SQL Server 2005 Service Pack 1 Setup.

12. Repeat step 11 for each additional SQL instance in this service group, if you have more than one instance in this service group.

13. From the Cluster Explorer, right-click the SQL Server service group which is still online and select **Unfreeze**

14. From the Cluster Explorer, right-click the SQL Server service group and select **Offline** on the node where it was online

15. Optionally reboot and online each service group to verify the database connect for each node.

16. Repeat step 9 through step 17 on each additional node if more than two SQL 2005 nodes are in use.

17. For a Disaster Recovery environment, repeat this procedure at the secondary site.
18 When Microsoft SQL 2005 Server Service Pack 1 has been completely installed on all nodes, test user connectivity to the instances.

19 Test the SQL Server service group by bringing it online and failing it over from node to node. When testing is complete, the upgrade is complete.

20 If more than one SQL Server service group is present, repeat this entire procedure for each SQL Server service group.

Upgrading Microsoft SQL 2005 to 2005 SP2 or later in a VCS environment

This section describes how to upgrade SQL 2005 to SQL 2005 SP2 or later. It is applicable only if you already have SQL 2005 set up in a VCS cluster environment.

**Note:** Do not follow the installation steps provided in this section to install SQL Server 2005 Service Pack 1 and all other hotfixes released before Service Pack 2.

Also, if you are performing the upgrade in a disaster recovery environment you must first upgrade all the cluster nodes at the secondary site and then upgrade the passive nodes at the primary site.

After all the primary site passive nodes are upgraded, you must upgrade the active nodes.

While you upgrade the cluster nodes on the secondary site, you may or may not choose to stop the replication. Replication does not affect the SQL upgrade.

**Prerequisites**

Consider the following points before applying Microsoft SQL 2005 Server SP2 or later service pack version to a production server:

- You must be a domain user having administrative privileges to the cluster nodes.
- You must have administrative privileges to the SQL instance that you want to upgrade.
- You must back up the SQL Server 2005 databases.
- Refer to the Microsoft documentation for prerequisites related to SQL Server 2005 Service Pack installation.

**Preliminary installation information**

Typically, multiple SQL instances are configured in a VCS cluster. Each SQL service group is configured to fail over on one or more nodes in the cluster. The node on
which the SQL service group is online is called as the Active node for that SQL instance. The node on which the SQL service group is offline is called as the Passive node for that SQL instance. The procedure for applying service packs, patches, or hotfixes for SQL instances varies depending on whether it is an active or a passive node. This document describes procedures for both the cases in detail.

Use the procedure that applies to the type of setup you have.

To provide context, the installation procedures described in this document assume two SQL Server 2005 instances configured in a three-node VCS cluster. Table 4-4 lists the configuration objects referenced in the following procedures.

<table>
<thead>
<tr>
<th>Table 4-4</th>
<th>SQL Server 2005 SP upgrade configuration objects</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Node1, Node2, Node3</td>
<td>Cluster node names</td>
</tr>
<tr>
<td>SQLinst1, SQLinst2</td>
<td>SQL Server 2005 instance names</td>
</tr>
<tr>
<td>SQLServer2005SP2-KB921896-x86-ENU.exe</td>
<td>SQL Server 2005 SP2 installer for 32-bit</td>
</tr>
</tbody>
</table>

The configuration is as follows:

- SQLinst1 can fail over on Node1 and Node2, and SQLinst2 can fail over on Node3 and Node2.
  So, Node2 is the common failover node for SQLinst1 and SQLinst2.

- The SQL service group for SQLinst1 is online on Node1, and the SQL service group for SQLinst2 is online on Node3.
  So, Node1 and Node3 are the “active” nodes for SQLinst1 and SQLinst2 respectively. Node2 is the “passive” node for both SQL instances.
  You will first install the service pack on Node2 (passive node) and then proceed to install on Node1 and Node3.

### Installing the Service Pack on “passive” cluster nodes

Perform these steps on all the nodes where the SQL service group is configured to fail over but is not online. You can either perform the installation at one time for all the SQL instances that are configured to fail over on the node, or repeat the steps for each SQL instance separately.

Do not run these steps for SQL instances whose corresponding service groups are online on the nodes (active nodes). For installation on active nodes,

See “Installing the Service Pack on “active” cluster nodes” on page 88.
**Note:** You can install SQL Server 2005 Service Pack in an unattended mode from the command prompt using the /quiet switch to suppress the setup dialog boxes. Refer to the Microsoft documentation for more information.

### To install the Service Pack on passive cluster nodes

1. Ensure that service groups for SQL instances SQLinst1 and SQLinst2 are offline on Node2.

   **Note:** This upgrade procedure will not upgrade the SQL instance whose corresponding service group is online on the node.

2. On Node2, copy the SQL Server 2005 Service Pack installer or map a drive to the directory where the installer is located.

3. From the command prompt on Node2, navigate to the directory where the installer is located.

4. From the command prompt, run the Service Pack installer command with the appropriate options.

   For example,

   The command format for running the installer is as follows:

   ```
   SQLServer2005SP2-KB921896-x86-ENU.exe [options] /passive=1
   ```

   You can use the following options for the command:

   - **/allinstances**
     This option upgrades all SQL Server 2005 instances and shared components to the desired SQL Server 2005 SP.

   - **/instancename = "<instance1>, <instance2>, ..."**
     This option upgrades only the specified SQL Server 2005 instances and shared components to the desired SQL Server 2005 SP.

   You can run any of the following commands on Node2:

   ```
   SQLServer2005SP2-KB921896-x86-ENU.exe /allinstances /passive=1
   ```

   or

   ```
   SQLServer2005SP2-KB921896-x86-ENU.exe /instancename = SQLinst1, SQLinst2 /passive=1
   ```
Note that in case of multiple SQL instances, there should be no spaces between instance names in the command.

5 Follow the upgrade wizard to complete the installation.

Once the installation is complete on the passive nodes, proceed to install on the active nodes.

**Installing the Service Pack on “active” cluster nodes**

Perform these steps on all the nodes on which the SQL service group is online. You can either perform the installation at one time for all the SQL instances that are configured to fail over and are online on the node, or repeat the steps for each SQL instance separately.

Do not run these steps for SQL instances whose corresponding service groups are offline on the nodes (passive nodes). For installation on passive nodes, see “Installing the Service Pack on “passive” cluster nodes” on page 86.

Referring to the configuration example described earlier, run these steps on Node1 and Node3 where the SQL service groups for SQLinst1 and SQLinst2 are online.

**To install the Service Pack on active cluster nodes**

1 Ensure that the SQL service group for SQLinst1 is online on Node1.

2 In the SQL service group for SQLinst1, take all resources of type SQLServer2005 offline on Node1.

   If there are other SQL Server 2005 instances configured on the node that you want to upgrade, take SQLServer2005 resources of the respective service groups offline as well.

3 From the Services snap-in, stop the SQL server Full Text Search service and the Analysis service, if they are not configured as part of the SQL service groups.

4 Freeze the SQL service group for SQLinst1 on Node1.

   From the Cluster Manager (Java Console), right-click the SQL service group, select **Freeze** and click **Temporary**.

   or

   Type the following on the command prompt: `hagrp -freeze service_group`

5 If the SQL Server Reporting Services is installed for a particular instance, start the SQL Server Database Service of the respective instance using the Services snap-in.
6 Run the SQL Server 2005 Service Pack installer.
   Double-click SQLServer2005SP2-KB921896-x86-ENU.exe to launch the SP installation wizard.
7 Follow the upgrade wizard to complete the installation.
8 After the installation is complete, stop the SQL Server services, if started before applying the patch.

   **Note:** SQLServer2005 resources may go in UNKNOWN state if we start the services outside the VCS cluster. Ignore this and probe the resources after installation is completed and all the services are stopped.

9 Unfreeze the SQL service group and probe the resources for SQLinst1 on Node1.
   From the Cluster Manager (Java Console), right-click the SQL service group, select **Unfreeze**.
   or
   Type the following on the command prompt: hagrp -unfreeze service_group
10 From the Services snap-in, start the SQL server Full Text Search service and the Analysis service, if they are not configured as part of the SQL service groups.
11 Ensure that all the services related to the SQL Server 2005 instance are in stopped state
12 Apart from the SQL Browser service, set the startup type of all the SQL services to manual.
13 Bring the SQLServer2005 resources in the SQL service group for SQLinst1 online on Node1.
14 Repeat step 1 to step 13 for SQLinst2 on Node3.

**Upgrading Microsoft SQL 2008 or 2008 R2 with the latest service packs in a VCS environment**

Use this procedure to perform the following upgrades:
- SQL Server 2008 to SQL Server 2008 SP1, SQL Server 2008 SP2, or SQL Server 2008 SP3.
- SQL Server 2008 R2 to SQL Server 2008 R2 SP1
Consider the following points before proceeding with the upgrade:

- You must have administrative privileges to the SQL instance that you want to upgrade.
- Make sure that you have a recent backup of your system and user databases.
- Make sure that the VCS version installed is VCS 5.1 SP2 or later.
- Refer to the Microsoft documentation for prerequisites related to SQL Server 2008 or 2008 R2 Service Pack installation.

Consider a two node cluster, Node A and Node B. The SQL service group is ONLINE on Node A, and Node B is the passive node.

You can upgrade SQL Server in any of the following ways:

- Upgrade SQL Server on all the nodes parallely.
  
  See “To parallely upgrade SQL Server on all the cluster nodes” on page 90.

- Upgrade SQL Server on the passive node first and then upgrade the active nodes.
  
  See “To upgrade SQL Server on the passive nodes first” on page 90.

Use the following procedure to parallely upgrade SQL Server on all the cluster nodes:

**To parallely upgrade SQL Server on all the cluster nodes**

1. Freeze the service group on Node A (active node).
2. Upgrade the SQL 2008 instance on Node A and Node B.
3. Reboot the nodes, if it prompts for.
4. Unfreeze the service group on Node A.

Use the following procedure to upgrade SQL Server on the passive node first and subsequently on the active node.

**To upgrade SQL Server on the passive nodes first**

1. Freeze the service group on Node A (active node).
2. Confirm all SQL services are stopped on Node B.
3. Upgrade the SQL Server 2008 instance on Node B.
4. Reboot node B.
5. Unfreeze the service group on node A.
6. Fail over the service group to Node B.
7. After the service group comes online, freeze the service group on Node B.
8. Confirm all SQL services are stopped on Node A.
9  Upgrade the SQL Server 2008 instance on Node A.
10  Reboot Node A.
11  Unfreeze the service group on node B.
12  Fail back the service group to Node A.
Upgrading Veritas Cluster Server

Upgrading the Microsoft service packs
Services and ports used by VCS

This appendix includes the following topics:

- About VCS services and ports

**About VCS services and ports**

If you have configured the Windows firewall, then ensure that the firewall settings allow access to the services or ports used by VCS.

Table A-1 displays the services and ports used by VCS.

*Note:* The following port numbers that appear in bold are mandatory for configuring VCS: 2148, 14150, 14141, and 7419.

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Protocol</th>
<th>Description</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>14150</td>
<td>TCP</td>
<td>Veritas Command Server</td>
<td>cmdServer.exe</td>
</tr>
<tr>
<td>14141</td>
<td>TCP</td>
<td>Veritas High Availability Engine (had.exe)</td>
<td>VCSAgent driver (VCSAgDriver.exe)</td>
</tr>
<tr>
<td>Port Number</td>
<td>Protocol</td>
<td>Description</td>
<td>Process</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>7419</td>
<td>TCP</td>
<td>Symantec Plugin Host Service Solutions Configuration Center (SFWConfigPanel.exe) CCF Engine (CEngineDriver.exe)</td>
<td>pluginHost.exe</td>
</tr>
<tr>
<td>1556</td>
<td>TCP/UDP</td>
<td>Symantec Private Branch Exchange</td>
<td>pbx_exchange.exe</td>
</tr>
<tr>
<td>2821</td>
<td>TCP/UDP</td>
<td>Symantec Product Authentication Service (VxSS)</td>
<td>vxatd.exe</td>
</tr>
<tr>
<td>8199</td>
<td>TCP</td>
<td>Volume Replicator Administrative Service</td>
<td>vras.dll</td>
</tr>
<tr>
<td>4145</td>
<td>UDP</td>
<td>VCS Cluster Heartbeats</td>
<td>vxio.sys</td>
</tr>
<tr>
<td>4888</td>
<td>TCP</td>
<td>Veritas Scheduler Service Use to launch the configured schedule.</td>
<td>VxSchedService.exe</td>
</tr>
<tr>
<td>49152-65535</td>
<td>TCP/UDP</td>
<td>Volume Replicator Packets</td>
<td>User configurable ports created at kernel level by vxio .sys file</td>
</tr>
<tr>
<td>14144</td>
<td>TCP/UDP</td>
<td>VCS Notification</td>
<td>Notifier.exe</td>
</tr>
<tr>
<td>14153, 15550 - 15558</td>
<td>TCP/UDP</td>
<td>VCS Cluster Simulator</td>
<td>hasim.exe</td>
</tr>
<tr>
<td>14155</td>
<td>TCP/UDP</td>
<td>VCS Global Cluster Option (GCO)</td>
<td>wac.exe</td>
</tr>
</tbody>
</table>
Index

A
About
  notification 23
  product reinstallation 36
  upgrade VCS; co-existing with Veritas
    NetBackup 47
After installing 31
After upgrading to 5.1 SP2 54
  changing the type definition default values 55
  importing the VCS management pack 55

B
Before installing 28
Before upgrading the cluster
  changing the driver signing options 47
  general preparations 46

E
Exchange cluster
  upgrade matrix 57

F
features
  adding 37
  removing 37
firewalls
  services and ports used 93

G
global clusters 24

H
Hardware requirements 10

I
installation
  adding or removing features 37
  license management 22
  repair 35
  Installation planning 22
  Installation requirements 9
  Installing
    using product installer 27
    VCS 28
  Installing VCS
    using command line 31

L
licensing 21
  adding or removing 22
  management 22

M
Microsoft Exchange 2003
  service pack 2
  configuring in a VCS environment 77
Microsoft Exchange 2007
  service pack upgrade 78
  Modifying driver signing options 28

N
Network requirements 10

O
Oracle cluster
  upgrade matrix 70
  Oracle cluster upgrading 70

P
print share service group
  bringing online after upgrade 54
product installer
  uninstalling 39

R
Recovery tools 25
  repairing installation 35
Requirements
    hardware 10
    installation 9
    network 10
Resetting the driver signing options 31

S
Service Pack Upgrade
    Microsoft SQL 2008 or 2008 R2 89
service pack upgrades
    Microsoft Exchange 2003 SP2 77
    Microsoft Exchange 2007 78
    Microsoft SQL 2000 SP4 82
    Microsoft SQL 2005 SP1 83
setup.exe parameters
    node 41
    Reboot 41
    Solution 41
SQL Server Cluster
    upgrade matrix 58
Supported
    Microsoft Exchange servers and the corresponding operating systems 13
    Microsoft SQL servers and the corresponding operating systems 14
    Network Appliance applications 21
    Operating systems 12
    operating systems and application versions 12
    Oracle versions and the corresponding operating systems 19
Symantec Product Authentication Service 23

U
uninstalling
    using command line 41
    using product installer 39
Upgrade
    Exchange server cluster 56
        upgrade scenarios 56
    Microsoft 2000 to SP4 82
    Oracle cluster 70
        upgrade scenarios 70
    SQL 2005 to 2005 SP2 or later 85
    SQL Server 2000 or 2005 to SQL Server 2008 or 2008 R2 on the additional failover node 62
    SQL Server 2000 or 2005 to SQL Server 2008 or 2008 R2 on the first node 62
Upgrade  (continued)
    SQL Server 2000 or 2005 to SQL Server 2008 or SQL Server 2008 R2 60
        Create SQL Server 2008 or 2008 R2 service group 63
    SQL Server 2000 to SQL Server 2005 58
    SQL Server 2008 to SQL Server 2008 R2 64
        additional failover node 67
        first cluster node 66
        modify SQL 2008 service group configuration 68
    SQL Server cluster 57
        Upgrade scenarios 58
upgrade
    Exchange 2010 to Exchange 2010 SP1; VCS environment 81
upgrading SFW HA
    bring print share service group online 54
Upgrading the cluster to 5.1 SP2 45